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1. はじめに 

 

アジレント・テクノロジーでは、マイクロアレイ実験をされる実務者の方を対象に DNA マイクロアレイ カ

ストマニュースを配信しています。実験プロトコルのアップデート・新製品のご案内・実験に関するトラブ

ルシュート・試薬や消耗品の保存など、実験を成功させるためのテクニカルサポートに内容を限定して、

E-mail でお送りしています。受信をご希望の方は「DNA マイクロアレイ カストマニュース配信希望」と明

記して、お名前・ご所属・配信を希望する E-mail アドレスを下記宛先までお知らせください。 

 email_japan@agilent.com 

 

 

プロトコルは予告なく変更になることがあります。プロトコルを日本語化するにあたり、作業時間が発生

するため、日本語プロトコルは英語の最新バージョンに比べて、どうしても遅れが生じます。製品ご購入

の際は、必ず製品添付の英語版プロトコルの Version をお確かめの上、日本語版が古い場合は、最新

の英語版を参照下さい。 

 

 

【更新履歴】 

Ver.2.4 から ver.3.1 への変更点 

・ 保証期間の記述を変更しました。 

・ オーブンの校正方法を記載しました。 

Ver.2.3 から ver.2.4 への変更点 

・ Agilent SureScan Microarray Scanner に対応しました。 

 

Ver.2.2 から ver.2.3 への変更点 

・ 実験手順は同一のまま、より多くのコンテンツで解析可能な SurePrint G3 8x60K マイク

ロアレイフォーマットに対応しました。SurePrint G3 8x60K フォーマットマイクロアレイの

スキャンには、高解像度仕様のアジレント C スキャナが必要です。 

 

Ver.1.x および ver.2.x の違い 

・ Ver.2.x ではサンプルのラベル化と、miRNA マイクロアレイへのハイブリに必要な試薬全

てが含まれた、Agilent miRNA Complete Labeling and Hyb Kit (p/n 5190-0456)が

使用されています 

・ Ver.1.x に比べて ver.2.x は反応 Volume がより少ない、新しいラベリングプロトコルに変

更になりました 

mailto:email_japan@agilent.com
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2．実験に使用する器具・試薬・ソフトウェアの確認  

2-1. 試薬 

 

■Agilent miRNA Complete Labeling and Hyb Kit には、ラベリングとハイブリダイゼーションに必要  

  な以下の試薬が、全て含まれます。 

 •Calf Intestinal Alkaline Phosphatase (CIP) 

 •10X Calf Intestinal Phosphatase Buffer 

 •T4 RNA Ligase 

 •10X T4 RNA Ligase Buffer 

 •Dimethyl sulfoxide (DMSO) 

 •Nuclease-Free Water 

 •Cyanine 3-pCp 

 •10X GE Blocking Agent 

 •2X Hi-RPM Hybridization Buffer 

■microRNA Spike-In Kit には、アレイ実験の成否判断に有用な以下の試薬が含まれます。 

 -Labeling Spike-In 

 -Hyb Spike-In 

 -Dilution Buffer 

【試薬・消耗品の保管について】 

■miRNA Complete Labeling and Hyb Kit に含まれる試薬の保存は以下に従って下さい。 

2x Hi-RPM Hybridization Buffer と調製前の 10xBlocking Agent 室温 

調製後の 10xBlocking Agent とそれ以外の全ての試薬  －20℃ 

■Cyanine 3-Cytidine Bisphosphate と Spike-In kit の Hyb-Spike In は蛍光色素を含むため遮 

  光に注意して保存して下さい。 

■開封前のマイクロアレイは、室温で保存をして下さい。マイクロアレイのフォイルの袋開封後は、マイ 

  クロアレイのスライドは室温の暗所で、真空デシケータか窒素パージしたボックスで保管をしてくださ 

  い。開封後は外気との接触を極力避けて下さい。 
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2-2. ラベル化・ハイブリダイゼーションに必要な器具・消耗品 
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【試薬・消耗品の保証期間について】 

・ アジレントマイクロアレイおよびその他のアジレント製品の保証期間は、箱やチューブの入った小袋

あるいはボトルに記載の Expiration date(Exp. date)までです。保証期間を過ぎた製品については

欠品等があった場合も交換ができない場合がありますので、製品が納品されたらすぐに内容物を確

認して下さい。 

・ 保証期間を過ぎると性能の保証ができないため、保証期間内に使用するように計画して下さい。 

 

 

 

実験に使用する全ての試薬・消耗品のロット番号と Expiration Date を記録して下さい。お問い合わせ

頂く際はこれらの情報を添えて、お問い合わせ下さい。 
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2-3. スキャン・数値化に必要なスキャナ・ソフトウェア 

 

本プロトコルでは、8x15K マイクロアレイもしくは 8x60K マイクロアレイのいずれかにラベル化 miRNA を

ハイブリダイゼーションする手順について説明しています。使用予定のマイクロアレイのフォーマット、ま

た Spike-In Control を使用するか否かに応じて、以下のバージョンのスキャナ及びソフトウェアが必要に

なります。 

* Resolution を”5 um”から”5 um high sensitivity”に変更してください。 

 

【スキャナについて】 

8x15K miRNA マイクロアレイは、いずれのスキャナでも読み込むことができ ますが、8x60K 

miRNA マイクロアレイのスキャンには 3um で読み取り可能な SureScan、または高解像度 C

スキャナが必要です。 

【Feature Extraction のバージョンについて】 

8x15K miRNA マイクロアレイの数値化には、Feature Extraction ソフトウェアバージョン 9.5

以上が必要です。8x60K miRNA マイクロアレイの画像の数値化には、FE10.5 以上が必要で

す。 

  

 マイクロアレイのフォーマットに関わらず、Agilent microRNA Spike-In の結果を自動的に QC

 レポートに表示させるには FE10.7.3 以上が必要です。 

 

Microarray 

Format 

Scanner 

version 

Scan 

Control 

version 

Scan settings/profile Spike-In Feature Extraction 

version 

GeneSpring 

version 

8x60K SureScan 9.X AgilentG3_HiSen_miRNA Yes 10.7.3 or later 11.5 or later 

8x60K SureScan 9.X AgilentG3_HiSen_miRNA No 10.7.3 or later 10.0 or later 

8x15K SureScan 9.X AgilentHD_miRNA* Yes 10.7.3 or later 11.5 or later 

8x15K SureScan 9.X AgilentHD_miRNA* No 10.7.3 or later 10.0 or later 

8x60K C 8.X AgilentG3_HiSen_miRNA Yes 10.7.3 or later 11.0 or later 

8x60K C 8.X AgilentG3_HiSen_miRNA No 10.5 or later 10.0 or later 

8x15K C 8.X AgilentHD_miRNA* Yes 10.7.3 or later 11.0 or later 

8x15K C 8.X AgilentHD_miRNA* No 10.5 or later 10.0 or later 

8x15K B 7.X 36 ページを参照してください. Yes 10.7.3 or later 11.0 or later 

8x15K B 7.X 36 ページを参照してください. No 9.5.3 or later 10.0 or later 
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3．実験を始める前に 

≪実験上のご注意≫ 

・ 必ず白衣、手袋、必要に応じてマスク、眼鏡をご着用ください。 

・ 実験を確実に成功させるために、ラベリングとハイブリダイゼーションに使う input RNA の分解度

合いをチェックして下さい。 

・ 清潔に保たれた空間で、作業をして下さい。 

・ 凍結している試薬を使用する場合は、次のことを守って下さい。 

1. 室温以上への過熱を避け、出来るだけ素早く溶解する 

2. 素早く混合し、5-10 秒 Flash して壁やふたの試薬を底に集める 

3. 使用直前まで、氷上か Cold Block に保つ 

・ Cyanine 3‐pCp は光で分解します。出来る限り光にあたらないように注意して使用してください。

保管時，反応時は必ず遮光してください。 

・ 全般的に、Biosafety Level 1 (BL1)の Safety Rules に従って下さい。 

・ 実験に使用する全ての試薬・消耗品のロット番号と Expiration Date を記録して下さい。お問い合

わせ頂く際はこれらの情報を添えて、お問い合わせ下さい。 

 

安全上のご注意 

・ スライドグラスの縁は鋭利です。手袋をはめ、十分注意して取り扱ってください。 

・ 本実験では、毒性のある試薬を使用します。操作時の安全には、十分ご注意ください。RNase の

コンタミネーションを防ぐために、実験中はパウダーフリーの手袋を着用し、ヌクレアーゼフリーの

溶液およびピペットチップを使用してください。 

・ ジメチルスルホキシド（DMSO）は吸入、皮膚接触、誤飲により、害を引き起こす恐れがあります。

DMSO の蒸気・霧は、目・粘膜や上気道に対して刺激性です。皮膚の炎症や呼吸器・皮膚にアレ

ルギー反応を起こすことがあります。実験動物試験の結果より、過曝露により生殖不全を起こす

可能性があります。 

・ 2x Hi-RPM Hybridization Buffer は OSHA Hazard Communication Standard (29CFR 

1910.1200)によって有害だとされています。誤飲により、害を引き起こす恐れがあります。このバ

ッファには、皮膚や中枢神経系に害を及ぼす可能性のある物質が含まれています。安全情報に

ついては MSDS を参照して下さい。 
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4．実験の流れ 

 

 

 

     

Total RNA（100ng） ＋Labeling Spike-In(オプション) 

↓ 脱リン酸化反応 ※ 

37℃で 30 分間インキュベーションする 

脱リン酸化 RNA  

↓ DMSO を加える 

↓ 熱変性、氷冷 

↓ ラベル化反応※  

16℃で 2 時間インキュベーション 

ラベル化 RNA  

↓ カラム精製（オプション）※ 

↓ 濃縮 ※ 

45℃から 55℃で約 2 時間～3 時間 

（カラム精製した場合は約 1 時間） 

↓ハイブリダイゼーション溶液調製 ＋Hyb Spike-In(オプション) 

↓熱変性、氷冷 

↓ハイブリダイゼーション  

55℃で 20 時間インキュベーション（20 rpm） 

↓洗浄、スキャニング 

miRNA のプロファイリング 

 

必要であれば、※印の操作の後、-80℃で保存することができます。 

 

 

本ラベリングシステムでは、100 ng の Total RNA サンプルから miRNA を蛍光標識します。本法では、

90％以上の効率で RNA 分子の３’末端に 1 分子の Cyanine 3-pCp を付加します。 

注意 本ラベリングシステムでは、標識分子を Ligation するためターゲット miRNA の 3’端に 

Accessible な水酸基を必要とします。(植物など)3’端が修飾を受けている生物種には本ラベ

リングシステムは使用できませんのでご注意下さい。 
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5．実験の操作手順〈１日目〉 

実験の前準備 

①実験を始める前に、以下の器具を準備してください。 

□マイクロピペッター（RNA 用） 1-10 uL,10-100 uL,100-1000 uL の３本 

□ピペットチップ（RNA 用） 上記各サイズ対応 

□チューブ立て 

□1.5 mL チューブ（RNase Free） 

□アイスボックス （クラッシュアイスの間隙を水で満たしたもの） 

□ヌクレアーゼフリー水 

□タイマー 

□Vortex ミキサー 

□パーソナル遠心機 

□油性ペン 

 

②あらかじめ使用する機器の温度設定をしておきます。 

１．ウォーターバスを 37℃に設定。 

２．ヒートブロックを 16℃、100℃に設定 

注意 使用する器具は、確実に設定温度になっていることを事前に温度計で確認して下さい。 

Step     Temperature     Time 

脱リン酸化 30min 

脱リン酸化                 37ºC      30 min 

熱変性 10min 

熱変性              100ºC      5 min 

冷却              氷上      2 min 

ライゲーション 120min 

ライゲーション                 16℃          120 min 

ハイブリダイゼーション 約120min 

サンプルの濃縮                45℃          1～2 h 

熱変性                     100℃           5 min 

冷却                       氷上           5 min 

ハイブリダイゼーション            55℃           20 h 

 

③実験に使う Total RNA サンプルを用意します。 

吸光光度計による濃度測定と、電気泳動による品質チェックを、あらかじめ行ってください。 

ノート   Total RNA の抽出法および品質チェックに関する推奨方法につきましては、巻末の

『Total RNA の評価』をご参照下さい。実験を進める前に本プロトコル全体を読んで

下さい。 
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5-1. Spike-In 溶液の調製（オプション） 

Agilent microRNA Spike-In キット(p/n 5190-1934)は、実験プロセスのコントロールのため

の 2 種類の microRNA Spike-In 溶液から成ります。Spike-In 溶液は、有意な生物学的データ

と実験プロセスでの問題を区別するためのツールとして使用します。Labeling Spike-In 溶液

はラベル化反応前にスパイクし、Hyb Spike-In 溶液はハイブリ反応前にスパイクします。一連

のプロジェクト内で、Spike-In を使用するかどうか統一することをお勧めいたします。 

 

注意   Hyb Spike-In は蛍光色素を含みます。保管および作業時は遮光を心がけて下さい。 

注意   原液及び 1st 希釈液の凍結融解は 2 回までにとどめて下さい。また希釈済みの 1st 希釈液は 

-80℃で 6 カ月まで保存が可能です。 

注意   この Spike-In はアレイデータの Normalization 目的には使用できません。 

注意   Drosophila Melanogaster の miRNA マイクロアレイには使用できません。Spike-In の配列 

は Drosophila Melanogaster の配列に由来しています。 

 

   

①Spike-In 溶液 1st 希釈作製と保存 （Spike-In キット開封時にのみ必要な作業） 

1. 全ての試薬を溶解し、軽く遠心する 

2. チューブを 10 本用意し、5 本に”1st 希釈 Labeling Spike-In”、残り 5 本に”1st 希釈 Hyb 

Spike-In”と記入する 

3. 各チューブに 198 uL の Dilution バッファを分注する 

4. “Labeling Spike-In”用チューブには Labeling Spike-In 溶液を 2uL、”Hyb Spike-In”用チュ

ーブには Hyb Spike-In 溶液を 2uL 加える 

5. よく混ぜて軽く遠心する 

6. （オプション）凍結融解の繰り返しを避けるため、各 1st 希釈液を 20～50uL ずつの小分け

にし、それぞれ新しいチューブに分注する 

（少量に分けるほど 1 キットで処理できるサンプル数が多くなりますが、6 ヶ月以内に

実施予定の実験回数に応じて分注の量を加減して下さい） 

7. 保存用小分け 1st 希釈液は１つずつ使い、残りは-80℃で保存する 
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②それぞれ使用直前に、Labeling 及び Hyb Spike-In 溶液を希釈 

 （毎回の実験時に必要な作業） 

 1. チューブを Labeling 及び Hyb Spike-In 用にそれぞれ 2 本ずつ準備する  

  -2nd 希釈 Labeling Spike-In -3rd 希釈 Labeling Spike-In 

  -2nd 希釈 Hyb Spike-In  -3rd 希釈 Hyb Spike-In 

 2. 各チューブに 198uL の DNase/RNase free 水を分注する 

 3. それぞれ使用直前に、2nd 希釈液を作製する 

-1st 希釈 Labeling Spike-In を、2nd 希釈 Labeling Spike-In のチューブに 2uL 加える 

-1st 希釈 Hyb Spike-In を、2nd 希釈 Hyb Spike-In のチューブに 2uL 加える 

 4. よく混ぜて軽く遠心する 

 5. それぞれ使用直前に、3rd 希釈液を作製する 

-2nd 希釈 Labeling Spike-In を、3rd 希釈 Labeling Spike-In のチューブに 2uL 加える 

-2nd 希釈 Hyb Spike-In を、3rd 希釈 Hyb Spike-In のチューブに 2uL 加える 

 6. よく混ぜて軽く遠心する 

（※この 3rd 希釈液が、ラベル化反応もしくはハイブリ反応に使用されます） 

 7. 2nd 希釈液と 3rd 希釈液は使用後すぐ廃棄し、1st 希釈液は-80℃で保存する 

 

 

5-2. Total RNA の濃度調整 

実験を始める直前に、実験に使用するサンプルを適切な濃度に希釈します。 

 

注意  低濃度の RNAはサンプルチューブに吸着する恐れがあります。保管は 100 ng/uL 以上の 

       濃度で行い、希釈は実験を始める直前に開始して下さい。また、一旦希釈した RNAは、   

       保存できません。必ず要時調製して下さい。 

 

 ①Total RNA の濃度を測定します。濃度決定に使用する RNA 量を最小限に抑えるために、本プロトコ 

  ルでは NanoDrop 分光光度計を推奨しています。 

 

 NanoDrop のソフトウェアを起動し、”Nucleic Acid Measurement”のタブを選択します。 

 1.5 uL の DNase/RNase free 水で、NanoDrop でブランクを設定します。 

 1.0 uL の Total RNA を濃度測定に用います。 

 

 ②Total RNA を、50ng/uL の濃度になるように、DNase/RNase free 水または 1xTE(pH7.5)で希釈し  

  ます。 

 ③希釈した Total RNA を 2uL(100ng)、1.5mL チューブに分注し、氷上に保存します。 

 

注意   DEPC 処理水を使用した場合、この後の反応を阻害する恐れがあります。ここで使用する水は、

 必ず、Agilent miRNA Complete Labeling and Hyb Kit に含まれる水か、Invitrogen 社の

 DNase/RNase-free water (10977015)をお使いください。 



 

13 
 

5-3. 脱リン酸化反応 

 

 ①使用直前に、CIP マスターミックスを作ります。CIP （Calf Intestine Alkaline Phosphatase）と 10X  

CIP Buffer、Labeling Spike-In 3rd 希釈液(もしくは水)を以下の表 1 の組成で混合し、調製後使用ま

では氷上で保存して下さい。 

 

表 1 Labeling Spike-In 溶液を使用する場合の CIP マスターミックスの調製 

1反応分の必要量（uL） 8(+1)反応分の必要量（uL)

10x CIP Buffer 0.4 3.6

Labeling Spike-In
(3rd希釈液)

1.1 9.9

CIP 0.5 4.5

トータル量 2.0 18.0
 

 

(Option) Drosophila の miRNA の発現プロファイルを取りたい場合など、Spike-In を使用せずに実

 験をしたい場合は、Spike-In を水で置き換えた以下表 2 に従って下さい。 

  表 2(Option) Lablineg Spike-In 溶液をしない場合の CIP マスターミックスの調製 

1反応分の必要量（uL） 8(+1)反応分の必要量（uL)

10x CIP Buffer 0.4 3.6

DNase/RNase free水 1.1 9.9

CIP 0.5 4.5

トータル量 2.0 18.0

 

＊本プロトコル中の表には、1 サンプル分の必要量と、8ｘフォーマット 1 枚に必要な 8 サンプル分

（＋1 反応分＝計 9 サンプル分）の必要量を示します。一度に反応を行うサンプル数によって調

節をして下さい。 

 

 ②各サンプル（Total RNA 100 ng）に CIP マスターミックスを 2uL 加え、ピペッティングで穏やかに混合 

  します。 

 ③37℃のウォーターバスかヒートブロックで 30 分間インキュベーションします。 

 

ノート   

 

ノート 

 

 

直ちに実験を続けない場合、この後、－80℃で保存することが可能です。 

 

カラム精製のステップまで、同一チューブを使用しサンプルを移し替えないでください。 

96 well plate とサーマルサイクラーを用いる際は、PCR キャップを使用しシールは使用し

ないでください。またサーマルサイクラーと整合性のある 96 well plate をご利用ください。 
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5-4. 熱変性 

① サンプルに 2.8 uL の DMSO を加えて混合し、チューブの蓋を隙間がないようにきっちりと閉めま

す。 

 

 表 3  熱変性反応液の調製 

1サンプル中の量（uｌＬ)

現在のサンプル量 4.0

DMSO 2.8

トータル量 6.8
 

 

② 加熱中に蓋が開いてしまわないようにチューブキャップカバーをはめて 100℃のヒートブロックか

ウォーターバスで 5 分間から 10 分間インキュベーションします。 

 

注意  加熱中チューブの蓋が開かないように、キャップカバーなどをご使用下さい。 

注意  このステップでは 5 分以上、しかし 10 分を超えないように注意をして下さい。ラベリング効率に 

影響が出る恐れがあります。 

 

③ 待ち時間に、アイスボックスにクラッシュアイスを入れ、そこに水を加えた氷水を準備します。クラ

ッシュアイスに加える水の量は、チューブが水に浮いてしまわない程度に少なく、かつ氷に挿した

チューブの壁が水に浸る程度に多く、加減して下さい。適切な水量では、1.5 mL のチューブを氷

水に挿した際に、チューブの先端から 2/3 程度が氷水に浸り、蓋部分は氷の上に出ている状態と

なります。 

 

注意  変性した状態を保つために、確実にサンプルが冷えることが重要となります。そのため、氷では 

なく、水を満たした氷水をご使用下さい。 

 

④ 直ちに、キャップカバーをはめたまま、氷水を満たしたアイスボックスにサンプルを移し、2 分冷却

します。この際、蓋とチューブの隙間から氷水が入ってしまうのを避けるために、チューブの本体

の壁は下部 2/3 程度は氷水に浸し、チューブの蓋は氷水に浸けてしまわないようにご注意下さ

い。 

注意  サーマルサイクラーをご利用の際も必ず水を満たした氷水で2分冷却してください。 

 

 

⑤ 冷却後、キャップカバーを外してからサンプルチューブをスピンダウンし、氷上に置きます。アイス

ボックス内の氷水を廃棄し、ただちに次のステップに進んで下さい。 
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5-5. ライゲーション 

① 10x T4 RNA Ligase Buffer を、沈殿が完全に溶けるまで 37℃で加温しボルテックスで撹拌しま

す。 

 

注意  撹拌後、確実にBufferが室温に冷えてから次のステップに進んで下さい。T4 RNA Ligaseの活 

性、およびラベリング効率に影響する可能性があります。  

注意  Cyanine 色素は光で分解します。以後のステップは可能な限り遮光を心がけて下さい。 

注意  ライゲーションマスターミックスは調製後 15 分以内に使用するようにして下さい。15 分を超える 

とラベリング効率に影響が出る恐れがあります。 

② 新しい 1.5 mL チューブを用意し、下表に従ってライゲーションマスターミックスを調製します。 

  表 4 ライゲーションマスターミックスの調製 

1反応分の必要量（uL) 8(+1)反応分の必要量（uL)

10x T4 RNA LigaseBuffer 1.0 9.0

Cyanine3-pCp 3.0 27.0

 T4 RNA Ligase 0.5 4.5

トータル量 4.5 40.5

 

 ③ 各サンプルに、ライゲーションマスターミックスから 4.5uL ずつを加えて穏やかにピペッティンで混合 

    し、スピンダウンします。 

     表 5 ライゲーション反応液の調製 

1サンプル中の量（uL)

現在のサンプル量 6.8

ライゲーションマスターミックス 4.5

トータル量 11.3
 

④ 16℃のウォーターバスかヒートブロックで 2 時間インキュベーションします。 

ノート 直ちに実験を続けない場合、この後、－80℃で保存することが可能です。 
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5-6. サンプルの精製 (オプション) 

 ラベル化したサンプルから DMSO および未反応の Cyanine3-pCp を除去するために、Micro 

Bio-spin6 カラムで精製することができます。精製を行うと、実験ステップは一つ増えますが、後の濃

縮にかかる時間を短縮することができます。（このステップの待ち時間に、『6-7 サンプルの濃縮』で使

用する濃縮遠心機の準備を済ませて下さい） 

  このオプションのカラム精製を行わない場合、ライゲーション終了後すぐ 6-7 に進んで下さい。 

  

①BioRad 社の MicroBioSpin6 を、直前に 4℃の冷蔵庫から出してキットに添付の 1.5mL チューブに

サンプル名を記入し、以下の要領でゲル（充填剤）の調製を行います。(4℃では蓋つきチューブの蓋

が折れやすいため、蓋つきチューブのみ、先に冷蔵庫から出して室温状態で使うこともできます) 

1）. カラムを素早く数回転倒混和し、ゲルをバッファ中でよく懸濁する。カラム下方に気泡がで 

きた場合、タッピングにて泡を消す 

2）. カラム下方の先端を手でちぎり、キットに含まれる 2.0mL チューブにセットする 

3）. 緑色のキャップをはずし、バッファが重力によってカラムから滴り落ちるのを確認する。も 

し液体が全く落ちて来ない場合、緑色のキャップを再びカラムにかぶせてきゅっと押し、も

う一度キャップをはずしてから液が滴り落ちるのを確認する 

4）. バッファの液面がゲルベッドの最上部程度に下がるまで、約 2 分間、バッファが自然に流 

れ出るのを待つ 

5）. 全てのカラムで同様にバッファが流れ出たのを確認した後、2.0mL チューブ内に流れ出た 

バッファを捨て、再びカラムをセットする 

6）. カラムを 1000g で 2 分間遠心する (遠心後、カラム下部が 2.0mL チューブ内の廃液に接 

していないこと、カラムは半透明ではなく白い不透明な状態であることを確認) 

 7）. 2.0mL チューブを捨て、キットに含まれる新しい 1.5mL チューブにカラムを移す。 

注意  遠心速度は正確に設定して下さい（1000rpm ではなく 1000g）。遠心速度が遅すぎると、サン

プルがゲルベッドに残って溶出されない恐れがあります。遠心速度が速すぎると、精製が不十

分になる、もしくはカラムが壊れてしまう恐れがあります。 

 ②ライゲーションが終了したサンプルに、RNase-free 水を 38.7uL 加え、混合してスピンダウンします。 

    表 6 精製溶液の調製 

1サンプル中の量（uL)

現在のサンプル量 11.3

DNase/RNase free水 38.7

トータル量 50.0
 

 ③サンプル 50uL をステップ１で調製したカラムに静かに移し、1000g で 4 分間遠心します。 

 ④カラムから溶出された液が精製されたサンプルです。カラムを捨て、サンプルを氷上に置きます。サ 

  ンプル溶液は透明で薄いピンク色をしています。溶出量は各サンプル間でほぼ等しく、約50uLになり 

ます。この後ハイブリダイゼーションまで、この Micro Bio-Spin6 に付属のチューブを使用します。 

ノート 直ちに実験を続けない場合、この後、－80℃で保存することが可能です。 
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5-7. サンプルの濃縮 

  サンプルを完全乾固させて下さい。濃縮遠心機を 45℃から 55℃もしくは中高温設定にして下さい。 

  チューブの蓋を閉め、チューブを数回はじくことによって完全に乾燥したかを確認してください。はじい 

  た際にペレットが動く、あるいは液体が飛び散る状態だと乾燥は十分ではありません。 

 

注意  カラム精製を行わない場合、サンプル中には DMSO が存在しています。乾燥が不十分で 

DMSO が残存すると、ハイブリダイゼーションに悪影響を与えシグナル強度が低下するため、

このステップではラベル化後のサンプルを完全に乾燥させるようにして下さい。 

 

注意  カラム精製を行った場合は完全に乾燥するまで 1 時間程度、カラム精製を行わない場合、完全 

に乾燥するまで 2,3 時間必要ですが、45℃以下に設定した場合さらに時間がかかります。 

 

注意  濃縮中はサンプルに光が当たらないように、注意して遮光して下さい。 

 

ノート 直ちに実験を続けない場合、この後、－80℃で保存することが可能です。 

 

6-8. ハイブリダイゼーションの準備 

 

濃縮を行っている間に、次のものを準備してください。 

□アジレント オリゴ DNA マイクロアレイ  

□オリゴ DNA マイクロアレイ用 ハイブリダイゼーションチャンバ 

□ガスケットスライド 

□ピンセット（清潔なもの） 

□パウダーフリー手袋  

□マイクロピペッター1-10 uL,10-100 uL,の 2 本 

□ピペットチップ 上記各サイズ対応 

□1.5 mL エッペンチューブ（ヌクレアーゼフリー） 

□チューブ立て 

□高速遠心機 

□ボルテックスミキサー 

□アイスボックス（クラッシュアイスの間隙を水で満たしたもの） 

□タイマー 

 

□ヒートブロックを 100℃に設定  

□ハイブリダイゼーションオーブン（55℃に設定、ローターを取り付けておきます。） 

    庫内が表示温度で安定するまでに 1 時間~1 時間半かかります。早めに設定をしておいて下さい。 
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≪ハイブリダイゼーションオーブン温度の校正法≫ 

 ハイブリダイゼーションの温度はマイクロアレイのシグナル強度やノイズレベルに大きな影響を

及ぼします。表示温度と実測値が一致するか 3 ヶ月に 1 度は確認し、0.2 ℃以上異なる場合は下

記手順で校正してください。 

1. オーブンのローターと、使用するスライド数とバランスをあわせてチャンバをセットします。 

2. 温度を 55℃、回転数を 20 にセットし、温度が安定するまで 3 時間ほど待ちます。 

3. 校正済みの温度計をセットします。 温度センサー部位をとりつけます。この時センサー部位が

オーブンの壁につかないように、空間の温度をはかるようにして下さい。 

4. 3 時間程度、温度計の温度が安定するまで待ちます。 

5. 実測温度と設定温度を比較し、0.2 ℃以上異なるようであれば、次の手順で合わせます。 

6. オーブンの ▲ ボタンと ▼ボタンを同時に押し、温度表示が点滅するまで待ちます。あるいは 

▲ ボタンと ▼ボタンを同時に長押し、温度両側の「.」が点滅するまで待ちます。 

7. 点滅しているうちに、▲ボタンと▼ボタンで、表示温度を温度計が示す温度にあわせます。 

8. その後再度表示を 55℃にあわせ 3 時間ほど待ち、表示温度が実測値と合うか確認します。 

詳細は弊社サポートサイトの「Agilent G2545A ハイブリダイゼーションオーブン校正方法」

をご覧ください。 

 

10x Gene Expression Blocking Agent の準備 

・スピンダウンしてペレットをチューブの底に集めた後、DNase/RNase free 水 125 uL を、

Agilent miRNA Complete Labeling and Hyb Kit (5190-0456)に含まれる 10ｘ Gene Ex-

pression Blocking Agent のチューブに直接加えます。穏やかにボルテックスをして、溶解させ

ます。 

・Blocking Agent が完全に溶解しない場合は、37℃で 4-5 分温めて完全に溶解させて下さい。 

・もしチューブの壁やキャップに固着している物質がある場合、17,000g で 5～10 秒遠心し、チ

ューブの底に集めて下さい。 

・水に溶解した状態では、‐20℃で約 2 ヶ月まで保存できます。 

・使用前に凍結した溶液を溶かした時には、軽くボルテックスをして完全に溶解してください。 

 

 

① 1.5mLチューブにハイブリダイゼーション溶液を調製します。Spike-Inを使用する場合は以下A 

の手順で、使用しない場合はSpike-Inを水で置き換えた次ページB(Option)の手順に従って下さい。

マスターミックスは調製せずに、各チューブに順番通りに試薬を加えてください。 

 

A. 【Hyb Spike-Inを使用する場合】 

A-1. DNase/RNase free水17uLをサンプルに加え、乾固したRNAを完全に溶解させます。 

A-2. Hyb Spike-In溶液3rd希釈液を1uL、各サンプルに加えます。 

A-3. 10ｘ Gene Expression Blocking Agent 4.5uLと2x Hi-RPM Hybridization  

Buffer22.5uLを加え、ボルテックスで穏やかに混合してスピンダウンします。 
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 表7 Hyb Spike-In溶液を使用する場合のハイブリダイゼーション溶液の調製 

1サンプル中の量（uL)

現在のサンプル量 17

Hyb Spike-In
(3rd希釈液）

1

10x Gene Expression Blocking Agent 4.5

2x Hi-RPM Hybridization Buffer 22.5

トータル量 45
 

B.(Option)【Hyb Spike-Inを使用しない場合】 

B1. DNase/RNase free水18uLをサンプルに加え、乾固したRNAを完全に溶解させます。 

B2. 10ｘ Gene Expression Blocking Agent 4.5uLと2x Hi-RPM Hybridization  

Buffer22.5uLを加え、ボルテックスで穏やかに混合してスピンダウンします。 

 

     表 8 Hyb Spike-In 溶液を使用しない場合のハイブリダイゼーション溶液の調製 

1サンプル中の量（uL)

現在のサンプル量 18

10x Gene Expression Blocking Agent 4.5

2x Hi-RPM Hybridization Buffer 22.5

トータル量 45
 

 

 

ノート 

 

 

 

②チューブの蓋を、隙間がないようにきっちりと閉めます。加熱中に蓋が開いてしまわないように 

 チューブキャップカバーをはめて、100℃のヒートブロックで5分間インキュベーションします。 

 

③待ち時間に、アイスボックスにクラッシュアイスを入れ、そこに水を加えた氷水を準備します。クラッ

シュアイスに加える水の量は、チューブが水に浮いてしまわない程度に少なく、かつ氷に挿したチュー

ブの壁が水に浸る程度に多く、加減して下さい。適切な水量では、1.5 mL のチューブを氷水に挿した

際に、チューブの先端から 2/3 程度が氷水に浸り、蓋部分は氷の上に出ている状態となります。 

 

④加熱終了後、ヒートブロックからサンプルチューブを取り出します。この際、チューブが膨張してヒー

トブロックのウェルから抜けにくい状態となっていますが、チューブ本体を持ち、蓋が開いてしまわない

ように注意して引き抜きます。 

サンプルが 8 サンプルより多い場合、最善の結果のためには、以下の作業は 8 サンプル

を 1 セットとして、順番に行ってください。次のステップに進む前に、ハイブリチャンバ・ガス

ケットスライド・マイクロアレイをすぐに組み立てられるようにご準備下さい。 
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⑤直ちに氷水を満たしたアイスボックスにキャップをしたまま移し、遮光状態でサンプルを 5 分間冷却

します。この際、蓋とチューブの隙間から氷水が入ってしまうのを避けるために、チューブの本体の壁

は下部 2/3 程度は氷水に浸し、チューブの蓋は氷水に浸けてしまわないようにご注意下さい。 

注意   加熱中チューブの蓋が開いてしまわないようにキャップカバーなどをご使用下さい。加熱・冷却 

の過程で、キャップは大変開きやすい状態となっています。 

注意   冷却は15分を超えないようにご注意下さい。長過ぎるとハイブリダイゼーションの結果に影響 

が出る恐れがあります。 

  ⑥素早くスピンダウンしてチューブの壁やキャップについた水滴を落とし、直ちに次のステップに 

  進んでください。 
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5-9. マイクロアレイの取り扱い上の注意 

 

■マイクロアレイのプローブは、アレイスライドのラベル

に”Agilent”の文字が入っている面(アクティブ面)に載っていま

す。 マイクロアレイスライドに貼ってあるラベルに”Agilent”

の文字が入っている方が Active サイド(プローブが搭載されて

いる側)、数字のみが記載されたバーコードラベルが付いている面は Inactive サイドになります。ハイブリ

ダイゼーションを行う際は、アレイがプリントされている Active サイドに、必ずハイブリ溶液が接するよう

に注意してください。 

 

■スライドグラスを取り扱う際はパウダーフリーの手袋をはめ、スライドグラスの縁を注意深く持って

取り扱って下さい。スライド表面には両側とも決して触らないで下さい。 

 

■ハイブリダイゼーション開始後は洗浄終了まで、アレイを乾燥させないように注意して下さい。 

 

■ハイブリダイゼーションを行う前に、実験机を整理整頓して下さい。ハイブリダイゼーション器具の周り

はなるべく障害物がない状態を作ってから次ページ以降の操作を行って下さい。 

 

■ハイブリダイゼーションは水平な実験台で行って下さい。下記ハイブリエイドをお持ちの場合は、内蔵

の水準器で水平が確認できます。ハイブリダイゼーション作業を始める前に、予めご確認ください。 

 

■手でアレイスライドをガスケットスライドに乗せるのが難しい場合、オプションとして、ハイブリエイドを用

いてアレイスライドを乗せることが出来ます。 

 ※ハイブリエイドはハイブリダイゼーション作業を補助するオプションの器具です。 
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5-10. ハイブリダイゼーション 

 

ハイブリダイゼーションチャンバを組み立てるにあたり、以下が必要になります。 

■ハイブリダイゼーションチャンバ (G2534A) 

 

 

 

 

 

 

 

 

 

 

 

 

 

■ガスケットスライド： 8 パック用(G2534-60014) 

                                                

■（オプション）ハイブリエイド 

 

 

 

 

チャンバ－ベ－ス

チャンバ－カバ－

クランプ　　
アッセンブリ

スクリュー

ブリッジ

プラスチック製
ピンセット

チャンバ－ベ－ス

チャンバ－カバ－チャンバ－カバ－

クランプ　　
アッセンブリ

スクリュー

ブリッジ

クランプ　　
アッセンブリ

スクリュー

ブリッジ

プラスチック製
ピンセット
プラスチック製
ピンセット
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① ガスケットスライドのプラスチックカバーの端をつまみ、ゆっく

りとはがします。ピンセットを使ってガスケットスライドをパッケ

ージから取り出します。この時、スライドの縁以外には触れな

いようにしてください。パウダーフリーの手袋を着用した手で

ガスケットスライドの縁を持ち、ブロワーでスライド表面をまん

べんなく吹き飛ばして下さい。 

 

② チャンバベースの上に、ガスケットスライドをラベルに”Agilent”の文字あるいはバーコード番号が書

かれている面を上にして載せます。ガスケットスライドは、ハイブリダイゼーション溶液を介して直接

アレイに触れますので、ほこり等がつかないようにすばやくセットしてください。チャンバベースの 4 つ

の突起(図の矢印の部分)にしっかりはまるようにします。 

 

 

 

 

 

 

 

ガスケットスライドがしっかりとチャンバベースにセット

されているか確認し、正しくされていない場合は、再度

セットし直してください。 

（オプションのハイブリエイドを用いる場合、 

ここで次々ページの【参考手法】を参照下さい） 

 

 

 

③ 卓上遠心機でしっかりとスピンダウンした後、ハイブリダイゼー

ション溶液全量(蒸発の程度によって 42～45uL 程度になります)

をガスケットスライド上にアプライします。ガスケットの壁にまで

液が広がらないよう注意して下さい。 

 

 

 

 

注意   熱変性・冷却の過程で、蒸発などにより、各サンプルの最終量はそれぞれ異なる場合がありま

す。アプライ時に気泡の導入を防ぐ目的で、ピペットの吸引量をその都度調節して下さい。ハ

イブリダイゼーション溶液に気泡が導入されると、その後洩れが生じる危険があります。 
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注意   もしスライドガラス上のアレイ8個のうち使用しないアレイがある場合、バーコードから最も遠い 

アレイを空けるようにして下さい。また、使用しないアレイには、水で希釈をした

1xHybridization bufferを45uLアプライして下さい。 

 

注意   こぼれたり洩れたりするのを防ぐために、ハイブリダイゼーション溶液は、ガスケットスライドの

ウェルの中央にアプライしてください（上図参照）。ガスケットスライドのゴム製スペーサーに液

が触れると、漏れの可能性が高くなります。 

 

（オプションのハイブリエイド用いる場合、ここで次ページの【参考手法】を参照下さい） 

④ アレイ面(ラベルに”Agilent”と書かれている面) を下にして(ラベルに数字が書かれている面は上に)、

マイクロアレイスライドをチャンバベースにセットされているガスケットスライド上に載せます。アレイ

スライドの縁かラベル部分を持つようにしてください。マイクロアレイスライドを水平に保ったままガス

ケットスライドにのせます。アレイを正しくセットした後、チャンバや重なっているスライドグラスを動か

さないようにしてください。ハイブリダイゼーション溶液が漏れる原因になります。 

 

注意  アレイスライドの向きを間違えないようにして下さい。正しい向きであれば、ガスケットスライド

のラベルに記載の Agilent の文字とアレイスライドのラベルに記載の Agilent の文字が向か

い合うように重なります。 

注意  マイクロアレイスライドを水平に保ったままガスケットスライドに乗せるために、アレイスライドが

サンプルに接する直前、下写真のチャンバベースの4か所の突起でスライドの水平を確認して

下さい。 

 

 

 

 

 

注意  チャンバカバーをセットする前、“サンプル溶液が接しているアレイ”と“接していないアレイ”が

あるように見える場合がありますが、問題ありません。アレイスライドを乗せた後は、位置の微

調整などは行わず、すぐチャンバカバーを乗せて下さい。 
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※参考手法 

ハイブリエイドを用いることにより、手作業では水平に降ろしづらいマイクロアレイスライドを、サンプルを

アプライしたガスケットスライド上に安定して乗せることが出来ます。 

使用器具： ハイブリエイド (HYB-100) 

 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

① ガスケットスライドにサンプルをアプライし終

わった時点でチャンバベースの両端から各ハ

イブリエイドを差し込み、突き当たるまで動か

します。ガスケットスライドの端を、ハイブリエ

イドの突起部分が覆うような形となります。 

 

② アレイ面(Agilent と書かれているバーコード

面) を下にして(数字が書かれている方のバ

ーコード面は上に)、マイクロアレイスライドを

ハイブリエイド上に乗せます。アレイスライド

の縁またはバーコードシール部分を持つよう

にして下さい。バーコードシール側を先にハ

イブリエイドの上に置き、そこを押さえながら

もう片方をゆっくり下に倒すと作業が容易で

す。チャンバベースの 4 つの突起に当たらな

いように注意して下さい。この時、アレイスラ

イドはハイブリエイドに支えられてハイブリ液

には接していません。 

 

③ 左右のハイブリエイドを同時に引き抜いて下

さい。アレイスライドが水平に落ち、ガスケット

スライドと正しい位置で重なります。アレイス

ライドを乗せた後は、位置の微調整などは行

わず、すぐチャンバカバーを乗せて下さい。

引き抜く先に障害物などが無いようにして下

さい。 
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⑤ チャンバカバーを、チャンバベースの上にセッ

トします。カバーの向きを間違えないように注

意してください。 

 

 

 

 

⑥ クランプアッセンブリを、チャンバベースの丸くなっているコ

ーナー側から差し込み、完全にストップする位置まで移動

させます。ストップする位置はチャンバの中央部になりま

す。 

⑦ チャンバが水平に保たれていることをご確認した後、手で

スクリューをしっかり締めます。チャンバにダメージを与え

る可能性があるので、ペンチなどの道具は決して使用し

ないでください。 

 

⑧ 組み立て終了後、チャンバを垂直方向にして 2,3 回、回転させて、ハイブリ溶液がスライドガスケット

の全面に行き渡るようにします。次に、チャンバ内の泡が自由に動くことができるか確認してください。

ハイブリ溶液が行き渡っていない部分や、固定している泡により、ハイブリむらが起きる場合があり

ますので、泡が動かない場合には、チャンバを手にもって振ることで、泡を移動させます。 

 

⑨ 残りのスライドも同様に、上記の作業を行ってください。 
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⑩ チャンバの組み立てが終わりましたら、予め 55℃にセットしたオーブンのローターに差し込みます。

ハイブリダイゼーション中に外れることがないように、両端をしっかりと差し込んで固定してください。

必ずバランスをとってチャンバをセットするようにしてください。チャンバ数が奇数である場合、バラン

スを取るためにブランクのチャンバをローターにセットして下さい。 

 

 

 

 

 

 

 

 

 

 

 

 

組み立てたチャンバは、下図 a のようにチャンバのねじが横向きになるように差し込みます（左右ど

ちらでも構いません）。下図 b のようにねじが正面あるいは背面に向いた状態では、ハイブリダイゼ

ーションが不均一となります。 

a.                                         b. 

 

 

⑪ ハイブリダイゼーションオーブンの扉を閉め、回転数を 20rpm に設定します。 

⑫ 55℃で 20 時間ハイブリダイゼーションさせます。 

 

注意  ハイブリダイゼーションは必ず20時間以上行うようにして下さい。20時間を少し超えるような場

合も、比較をする結果同士は同じハイブリダイゼーション時間を保つように心がけてください。ハ

イブリダイゼーション時間が異なると結果に悪影響を及ぼす危険性があります。 

 

注意  ハイブリダイゼーションオーブンのローターには、バランスを取るようにチャンバをセットして下さ

い。 

 

Agilent ハイブリダイゼーション 

オーブン (G2545A) 

ハイブリダイゼーション オーブンロータ 

(G2530-60029) 

YES! NO! 
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5-11. 洗浄（2 日目）の準備 

 

1.Triton X-102 の Gene Expression Wash Buffer への添加 

最終濃度 0.005%になるように、Triton X-102 を Gene Expression Wash Buffer1 と 2 に添加する

ことで、マイクロアレイの洗浄におけるアーティファクトの可能性を軽減することができます。 

10% TritonX-102 は Gene Expression Wash Pack (5188-5327)に必要量含まれています。単体

でもご購入いただけます(50mL、5185-5975)。 

 

Gene Expression Wash Buffer 1 と 2 の開封時に、以下の方法で 10%Triton X-102 を加えま

す。この操作は、Wash Buffer１にも 2 にも行います。 

開封時に添加すれば、その後洗浄時に添加する必要はありません。 

 

1-1）.ダンボール箱中の容器の、外蓋と中蓋を注意深く開ける 

1-2）.ピペットで 2mＬの 10％ Triton X-102 を容器中の Wash Buffer に加える 

1-3）.中蓋・外蓋をきっちり戻し、5・6 回容器全体を転倒混和して、注意深くかつ 

しっかり混ぜる。 

  1-4).中蓋・外蓋を外し、Buffer に添付の蛇口を取り付ける 

  1-5).Wash Buffer の容器に『Triton X-102 添加済』と記載し、日付を記録する 

 

Gene Expression Wash Buffer 中の Triton X-102 の最終濃度が 0.005%になれば、開封済

みのより少ない量の Buffer にも添加することができます。 

 

2．Gene Expression Wash Buffer2 の予熱 

アレイの洗浄に用いる Gene Expression Wash Buffer 2 は、オーバーナイトで 37℃に加温

する必要があります。1 日目の実験終了後、恒温槽内などで、必要量の Gene Expression 

Wash Buffer 2 と、それを入れるための洗浄ディッシュの加温を始めて下さい。洗浄バッファ 2

を別容器に移して温める場合は、蒸発を防ぐため密閉容器を使用してください。 
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6．実験の操作手順〈2 日目〉 

 

 

6-1.洗浄の用意 

・洗浄を始める前に、以下の機器・器具を準備してください。洗浄・乾燥のステップは、できるだけ効率的

に行うために、洗浄用器具は、37℃のウォーターバスを含めてすべて近くに準備して下さい。 

・スライドグラス洗浄用ガラス容器（小 3） 

・スライドラック(サーモエレクトロン 109) 

・スターラー（2） 回転子（ラック小（サーモエレクトロン 109）の場合 3.0cm 程度のもの 2 

ラック中（サーモエレクトロン 113）の場合 4.5cm 程度のもの 2）  

  ※回転子の大きさが十分でない場合、洗浄力が弱くなる恐れがあります。 

・タイマー 

・スターラー付恒温槽（アズワン株式会 1-5088-01 あるいは株式会社日伸理化 SW-500NT） 

・ピンセット 

・パウダーフリーの手袋 

※パウダーフリーの表示があっても、蛍光を持つ粒子が手袋についている場合があります。事前に、

確実に手袋から微粒子が発生しないことをご確認ください。確認のためには、ビーカーに入れた

Wash1 の溶液で手袋を事前に洗ってみて、手袋から垂れる Wash 溶液が白濁していないこと、

および手袋をあらった後の、ビーカー内の溶液に微粒子がないことを確認してください。手袋から

発生する微粒子は、アレイの表面に吸着して結果に大きな影響を及ぼします。 

     

注意  洗剤の中には、ディッシュに蛍光が残留するものがあります。いかなる洗剤も、ディッシュの洗浄

には使用しないようにして下さい。 

 

注意  miRNAマイクロアレイの洗浄は、オゾン濃度が50ppb以下の環境で行ってください。オゾン濃

度が50ppbを超える場合、オゾンフリーブース内で洗浄・スキャンを行うか、洗浄後にオゾンバリ

アカバーを使用するか、いずれかの対策を施して下さい。 

 

 

 

6-2. マイクロアレイの洗浄 

  表 9 洗浄の概要 

Step    ガラス容器 温度     時間 

ガスケットスライドと 

アレイスライドの分離          1         室温      

洗浄バッファ1       2         室温       5 min 

洗浄バッファ2       3         37℃       5 min 
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1． 洗浄バッファと洗浄用ガラス容器の準備 

 1－1） スターラー付恒温槽を、37℃に設定します。 

 1－2） 下記の通り 3 つの洗浄用ガラス容器を準備し、バッファを容器に注ぎます。 

 ガラス容器 1 : 洗浄バッファ 1:  ガスケットスライドとアレイスライドの分離 

 ガラス容器 2 : 洗浄バッファ 1:  スライドラックと回転子を中に入れておきます 

ガラス容器 3 : 洗浄バッファ 2:  回転子を中に入れておきます 

 

注意   洗浄バッファ 2 は、恒温槽が確実に 37℃になったことを確認した後に、容器 3 に注ぎ、直ち 

に恒温槽内にセットして下さい（下右写真参照）。 

 

 

 

 

 

 

 

注意   注意深く洗浄プロトコルに従ってください。また指定の器具を使用してください。洗浄時間を守 

ることは非常に重要です。洗浄時間がプロトコルの時間から外れた場合には、結果がばらつ 

いてしまう場合があります。また、スライド洗浄を行う際の攪拌には、シェーカーを使わずに、 

必ずマグネットスターラを使用して下さい。 

 

2. ハイブリオーブンからチャンバを取り出します。複数のアレイをハイブリダイゼーションしている 

場合も、チャンバは必ず１つずつ取り出すようにしてください。各チャンバを取り出した時刻・ハ

イブリ時間を記録して下さい。泡が形成されているか、また泡が自由に動いているか確認してく

ださい。ハイブリダイゼーション溶液に、明らかな減少があった場合は、その量を記録して下さ

い。 

 

＜注意＞ チャンバをオーブンから取り出し、

室温で静置すると、放置時間に応じて、

ハイブリ液の覆っている部分と気泡の

部分で、シグナル強度に差異を生じま

す（下図参照）。オーブンから取り出し

たチャンバは、必ずすぐに解体し、アレ

イスライドを Wash1 中のスライドラック

に移すことが重要です。また複数枚の

スライドを一度に wash する場合も、1

スライドずつ取り出し、解体の直前まで、

規定の温度で回転していることが重要

です。 

 

 

0 min 5 min

15 min 30 min

室温放置の影響を検証したデータ 
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3. チャンバの分解 

a. チャンバを水平な台の上に置き、スクリューを逆時計回りにまわしてゆるめます。 

b. クランプアッセンブリを外し、チャンバカバーを取り除きます。 

c. 手袋をはめた手で、チャンバベースから重なっている 2 枚のスライドを同時に取り出します。

この時、スライドの両端をしっかり持つようにしてください。すぐに、アレイスライドを上にした

状態で(数字が書かれているバーコード面を上にして)、2 枚のスライドが重なっている状態で

ガラス容器 1 内の洗浄バッファ 1 に浸けます。 

 

4. 2 枚のスライドが完全に洗浄バッファ 1 に浸かった状態で、スライドのバーコード側から 2 枚のス

ライドを離します。 

a. ピンセットの先端を 2 枚のスライドの間に差し込み、ゆるやかにピンセットを上側または下側 

に回転させてスライド同士を離します。 

b. ガスケットスライドのみを容器の底に落としてください。  

 

※参考手法 

ピンセットを用いることにより、洗浄液に手袋を浸さないでアレイを洗浄することができます。 

 使用器具： フラットピンセット 33A (品番は p.6 参照)  

     

注意：従来の超精密ピンセットNo.T よりも先の丸い部分が大きいため、丸い部分の半分以上でガラス面を持  

  たないよう注意が必要。 

 

①2 枚のスライドをピンセットで挟み、 ②バーコード側のピンセットを ③両手でスライドガラスを 

 立てた状態でガラス容器１に入れる。 2 枚のスライドガラス間に入れ しっかりはさみ、 

 アレイ面を傷つけないように ガラス容器２中の 

  ガスケットスライドをはがす。 ラックに運ぶ。 

 

1 2 3
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5. アレイスライドをすばやく取り出し、洗浄バッファ１を入れたガラス容器 2 にセットされているラック

に差し込みます。 

 

注意  スライドグラスを扱う時は、バーコード部分かスライドグラスの縁を持つようにします。決してマ

イクロアレイに触れることがないように注意してください。アレイが空気に触れる時間を最小限

に抑えてください。 

 

   6. 残りのチャンバも同様に解体して、すべてのスライドをラックに差し込みます。全てのスライドで、

 アレイ面がラックの中心を向く向きに揃えます。一度に洗浄するアレイは 5 枚もしくは 8 枚以下にする

 ようにしてください。 

 

注意  スライドグラスをラックに差し込む際は、洗浄の効率を保つ持つために端は 3 つ以上、スライド

グラス間は 2 つ以上空けてください。19 スライドラックは最大 5 枚、30 スライドラックは最大 8

枚洗浄可能です。 

      19 スライドラック(Ｔｈｅｒｍｏ Ｓｈａｎｄｏｎ109)    30 スライドラック（Ｔｈｅｒｍｏ Ｓｈａｎｄｏｎ113） 

 

 

 

 

 

 

 

7. すべてのアレイがスライドラックにセットできたら,中程度の回転数で室温のまま 5 分間 攪拌しま

す。この時、スターラーや洗浄ディッシュ全体を覆うように、遮光をして下さい。 

 

注意  アレイスライドおよびスライドラックを入れた状態で、液面が波立つ程度の速さで攪拌してくださ

い。スライドグラスの枚数、液量によって回転数は異なるので、その都度調節してください。回

転速度が十分でない場合、洗浄力が弱まる恐れがあります。 

 

8. スライドラックを洗浄バッファ２（ガラス容器 3）にすばやく移します。中程度の回転数で 37℃に保

った状態で、5 分間 攪拌します。この時、スターラーや洗浄ディッシュ全体を覆うように、遮光を

して下さい。 

 

注意  このステップを 37℃に保つことは非常に重要です。温度管理を行わないと、洗浄の厳しさが変

化することになり、実験結果が変動する危険性があります。 

 

9. 洗浄バッファ 2（ガラス容器 3）からスライドラックを取り出します。この時、スライドラックを水平に

保ち、スライド上に水滴が残らないように注意しながら、5-10 秒かけて引き上げてください。 
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10. この操作でスライドガラスは乾燥しますので、その後ただちにスキャンを行うことができます（窒

素ガスによる乾燥は必要ありません）。すぐにスキャンをしない場合は、窒素パージして暗所で保

管してください。必要でしたらスキャン後に、スライドグラスはポリプロピレンスライドボックスに入

れ（コルクなどの詰め物をしないでください）、真空デシケータまたは窒素パージボックスに入れて

暗所で保存します。真空デシケータの方が色素の退色が見られるため、窒素パージボックスをお

勧めします。 

ノート 9 枚以上を同じ日にハイブリさせた場合など、1 日の洗浄が 2 回以上になる場合は、洗浄バッファ 

     はその都度新しいものに交換してください。 

ノート カラム精製をしなかった場合、ガスケットスライドとアレイスライド分離に用いた Wash Buffer は、

取り込まれなかった Cyanine 3 色素のために、ピンク色をしていることがあります。所属機関の適切

なガイドラインに沿って廃棄してください。活性炭フィルターなどを利用し使用済みの Wash Buffer

から取り込まれなかった色素を吸着させることもできます。 

 

≪ガラス容器およびチャンバの洗浄法≫ 

洗浄に使用するガラス容器やラック、回転子等はマイクロアレイの洗浄専用にしてください。使用後は

洗剤を使わずに水洗いをしてください。洗剤が残っている器具を使用すると、マイクロアレイに洗剤が

付着し蛍光を発する場合があります。 

1. チャンバ、ガラス容器、回転子およびラックを水道水ですすぎます。汚れが気になる場合は、洗剤

がついていないスポンジあるいはキムワイプ（ペーパータオルは使用しないでください）でこすってく

ださい。 

2. 超純水でよくすすぎます。5 回ほどすすいでください。 

3. 埃がつかないように乾燥させます。 

 

≪ガラス容器などのメンテナンス≫ 

正しく操作されていても、汚れが洗浄器具に蓄積されるとアレイスライドに影響がでることがあります。 

スキャン画像にムラや粒上の汚れが観察されるなどの問題が起こった場合は、洗浄器具をクリーニング

すると改善する場合があります。以下の手順に従い、クリーニングをしてください。 

ガラス容器の洗浄には、アセトニトリルあるいはイソプロパノール（IPA）を用います。アセトニトリルは劇

物なのでドラフト内で使用するなど取扱いにご注意ください。 

ステンレスラック、スターラー、使用している場合はピンセットなどの洗浄器具をガラス容器に入れ、アセ

トニトリルあるいは IPA を満たした状態で 5 分～数時間おきます。 

アセトニトリルあるいは AIP を廃棄した後、ミリ Q 水で洗浄器具全てを徹底的に５回以上リンスしてくださ

い。 

洗浄器具をホコリがつかない環境で自然乾燥してください。 

 

≪ミリ Q システムのメンテナンス≫ 

ガラス容器などをミリ Q 水でリンスする際、高い水質であることを確認してください。ミリ Q システムのフィ

ルターや UV ランプなどの使用期限が過ぎていると水質が悪くなり、ガラス容器などを介し、洗浄したスラ

イドグラスに影響を与えることがあります。参考値: 比抵抗 18.2MΩ･cm, TOC<4 
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6-3. Agilent スキャナを用いたスキャニング 

マイクロアレイに貼られたラベルの数字の面が露出し、Agilent と記載のアレイ面がカバーに覆われ

ている向きで挿入します。 

a.  B スキャナまたは C スキャナをお使いの場合 

 

 

 

 

 

 

 

 

 

 

≪オプション：オゾンバリアスライドカバーの使用≫ 

オゾン濃度が 50ppb 以上の環境であれば、オゾン対策が必要です。すぐにスキャンを行う場合、オゾンバ

リアスライドカバーを使用すると、スキャン中のオゾンによる蛍光色素の退色を抑えることができます。 

 下図のように、スライドホルダに挿入したアレイスライドに重なるように、オゾンバリアスライドカバーを 

 置き、スライドホルダのカバーを閉めます。 

・スポット面を傷つける恐れがあるので、オゾンバリアスライド

カバーの向き（裏表、左右の向き）に気を付けてください。 

・スキャン中の退色のみに有効です。洗浄・乾燥時の退色は

オゾンバリアスライドカバーのみでは防ぐことはできません。 

・オゾンフリーブースをご利用の場合は、使用する必要はあり

ません。 

 

b. SureScan をお使いの場合 

 

アレイ面 

奥のつめにのせる 

“Agilent”と 記 載 の
面がホルダの上側
にくるように挿入 

① カバーを開けます。 
② スライドを載せます。 

“Agilent”と記載の面がホルダの上

側にくるように挿入 



 

35 
 

  ①スライドホルダのカバーを開けます。 

  ②’Agilent’と記載の面がホルダの上側になるように、’Agilent’の文字が奥側になるようにスライドを 

  載せます。 

 ③スライドホルダのカバーを閉めます。閉める際カチッと音がし、固く閉まっていることを確認して下さ 

 い。カバーのしまりが緩い場合は他のホルダを使用してください。スライドホルダは 1 台のスキャナに 

 24 個ついています(足りなくなりましたら購入も可能です。お問い合わせください)。 

 

   表 10 スキャナ・Feature Extractino・GeneSpring のバージョン情報 

* Resolution を”5 um”から”5 um high sensitivity”に変更してください。 

注意 マイクロアレイフォーマット、スキャナのバージョン、Spike-In 使用か否かなどによってスキャン

設定・コントロールソフトウェアの操作画面、必要な数値化ソフトウェアのバージョンが異なりま

すのでご注意下さい。 

 

【スキャナについて】 

8x15K miRNA マイクロアレイは、いずれのスキャナでも読み込むことができますが、8x60K miRNA マ

イクロアレイのスキャンには高解像度仕様の SureScan また C スキャナが必要です。 

 

【Feature Extraction のバージョンについて】 

8x15K miRNA マイクロアレイの数値化には、Feature Extraction ソフトウェアバージョン 9.5 以上が必

要です。SureScan、または C スキャナでスキャニングした 8x60K miRNA マイクロアレイの画像の数値

化には、FE10.5 以上が必要です。 

 

マイクロアレイのフォーマットに関わらず、Agilent microRNA Spike-In の結果を自動的に QC レポートに

表示させるには FE10.7.3 以上が必要です。 

Microarray 

Format 

Scanner 

version 

Scan 

Control 

version 

Scan settings/profile Spike-In Feature Extraction 

version 

GeneSpring 

version 

8x60K SureScan 9.X AgilentG3_HiSen_miRNA Yes 10.7.3 or later 11.5 or later 

8x60K SureScan 9.X AgilentG3_HiSen_miRNA No 10.7.3 or later 10.0 or later 

8x15K SureScan 9.X AgilentHD_miRNA* Yes 10.7.3 or later 11.5 or later 

8x15K SureScan 9.X AgilentHD_miRNA* No 10.7.3 or later 10.0 or later 

8x60K C 8.X AgilentG3_HiSen_miRNA Yes 10.7.3 or later 11.0 or later 

8x60K C 8.X AgilentG3_HiSen_miRNA No 10.5 or later 10.0 or later 

8x15K C 8.X AgilentHD_miRNA* Yes 10.7.3 or later 11.0 or later 

8x15K C 8.X AgilentHD_miRNA* No 10.5 or later 10.0 or later 

8x15K B 7.X 36 ページを参照してください. Yes 10.7.3 or later 11.0 or later 

8x15K B 7.X 36 ページを参照してください. No 9.5.3 or later 10.0 or later 
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B スキャナまたは C スキャナをお使いの場合 

（SureScan をお使いの場合は P. 40 を参照してください） 

1. レーザーを安定させるために、スキャンを開始する 20 分前までにスキャナの電源を入

れます。PC を起動した後にスキャナの電源を入れ、右図のアイコンをダブルクリックし

てスキャナコントロールソフトを立ち上げます。詳細は巻末を参照してください。 

 

スライドホルダにセットされたマイクロアレイをスキャナのカローセルにセットします。複数のスライドグラ

スをスキャンする場合は、隣り合うスロットにセットしてください。また、H と書かれている Home スロットに

はセットしないでください。スライドホルダのカバーがきちんと閉まっていることを確認してください。完全

に閉まっていない状態でスキャンを開始すると、スキャナ内でスライドホルダが引っかかってしまい、エン

ジニアによる修理が必要となることがあります。 

 

2. スキャナの蓋を閉じます。 

 

スキャナコントロールソフト ver.7（B スキャナ）をお使いの場合 

1. 画面下の”Scanner status”が『Scanner ready』になっていることを確認します。 

2. スライドを入れたスロット番号を、”Start slot”と”End slot”で指定します。 

3. 設定を変更するスライドをテーブル内で選択してください(複数枚選択できます)。選択されると青くハ

イライトされます。 

4. “eXtended Dynamic Range Scan Mode”にチェックを入れ、”Hi”を 100%に、”Lo”を 5%にします。 

5. “Edit Slot Values>>”をクリックしてメイン画面を拡張します。 

 

 

 

 

 

 

 

 

 

 

 

 

 
①  

② 

③ 

④ 

⑤ 
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6. 拡張された画面で、下の表に従って各種設定変更を行います。 

注意 8x15K マイクロアレイの場合は Scan resolution が 5um になっていることを確認してください

B スキャナは最高解像度が 5um であるため、8x60K マイクロアレイはスキャンできません。 

注意 miRNA の XDR Lo PMT 値は 5%で、遺伝子発現の 10%と異なるため注意して下さい。 

 

 

 

 

 

 

 

7. “Output path”で、スキャン画像を出力したいフォルダを指定します。 

8. 設定が終了したら、”Set Values”をクリックします（Set values をクリックしないと変更が反映されま

せん）。テーブル内の設定値が変更されたことを確認してください。 

9. スキャン設定が確認できたら、”Scan Slot n-m”をクリックするとスキャンが開始します。 

10. スキャンが終了したら、Scan Progress 画面の右下にある Close ボタンをクリックします。 

スキャナのロックがはずれ、スライドホルダを取り出せるようになります。 

11. コントロールソフトを閉じた後にスキャナおよび PC の電源を消してください。 

【参考】 XDR スキャン 

※eXtended Dynamic range：XDR スキャンは、１枚のスライドグラスを、異なった PMT（miRNA アレイ

の場合、デフォルト設定高 PMT：XDR Hi 100％、低 PMT：XDR Lo 5％）に変え、自動的に連続スキャン

する機能です。Feature Extraction 9.1 以降はこの 2 つのスキャンを自動的に１つにまとめ、広いダイナ

ミックレンジが得られる結果を自動的に出力することが可能です。 

 

⑥ 

⑦ 
⑨ 
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≪スキャンのデフォルト設定変更法≫ 

1. スキャナコントロールソフトを立ち上げ、ツールバーの Settings > Modify Default Settings を選択

します。 

2. 表示された Default Setting ボックス内で、変更したい項目を変更し、OK をクリックします。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

スキャナコントロールソフト ver.8（C スキャナ）をお使いの場合 

1. 画面下の”Scanner status”が『Scanner ready』になっていることを確認します。 

2. スライドを入れたスロット番号を、”Start slot”と”End slot”で指定します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. “Profile”リストから、以下のプロファイルを選択します。 

 ■8x15K miRNA マイクロアレイ→AgilentHD_miRNA 

  ■8x60K miRNA マイクロアレイ→AgilentG3_miRNA 

 もし G3 のプロファイルがない場合、次の方法でインポートします。 

①  

② ③ 

⑤ 

④ 
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【プロファイルの入手およびインポート】 

1．下記サイトから AgilentG3_Profiles.zip をダウンロードし、PC に保存します。 

https://www.genomics.agilent.com/GenericA.aspx?PageType=Custom&SubPa

geType=Custom&PageID=2074  

2．ダウンロードしたファイルを右クリック＞Open with(プログラムから開く)＞Compressed  

zipped folders あるいは Winzip と選択し、解凍します。  

3．解凍したファイル(AgilentG3_Profiles.pfl）をスキャナに付属の PC にコピーしてください。  

4．コントロールソフトの Tool> Profile Editor…と選択します。  

5．現れた Profile Editor 画面で Import をクリックし、保存した解凍ファイル 

(AgilentG3_Profiles.pfl）を指定します。  

  

6．Yes をクリックし、 Profile Editor 画面の Close をクリックします。  

 

4. 選択したプロファイルの項目で、個別に変更する必要があればプルダウンで変更します。 

下記■で示した項目が、Agilent miRNA マイクロアレイ(8x15K もしくは 8x60K)の用の初期設定です 

 変更できる項目 

 1). Dye Channel: □Red（1 カラー(Cy5)） 

■Green(1 カラー（Cy3）), 

□Red+Green（2 カラー） 

 2). Scan Region: □Full Slide 

             ■Agilent HD (アジレントアレイ) 

 

3). Scan Resolution: □2um, ■3um,(8x60K)  

■5um(8x15K), □10um  

4). TIFF file dynamic range: ■20bit 

□16bit  

 

5). R/G PMT gain: ■100% ～ □1% 

6). XDR ratio: 0.5, 0.33, 0.2, 0.1, 0.05, 

 ■NoXDR 

7). Output Path:  

  ※変更した設定は Profile に保存することができます。 [Profile>Save as] 

 

https://www.genomics.agilent.com/GenericA.aspx?PageType=Custom&SubPageType=Custom&PageID=2074
https://www.genomics.agilent.com/GenericA.aspx?PageType=Custom&SubPageType=Custom&PageID=2074
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5. スキャン設定が確認できたら、”Scan Slot n-m”をクリックするとスキャンが開始します。 

6. スキャンが終了したら、Scan Progress 画面の右下にある Close ボタンをクリックします。 

スキャナのロックがはずれ、スライドホルダを取り出せるようになります。 

7. コントロールソフトを閉じた後にスキャナおよび PC の電源を消してください。 

 

【参考】 16bit スキャンと 20bit スキャン 

※TIFF ファイルに保存されるシグナル強度範囲を指定します。 

20bit スキャンは、1 回のスキャンで 5 桁のダイナミックレンジでシグナル強度を保存できます。XDR スキ

ャンは不要なため、20bit スキャンを選択すると XDR 機能はオフになります。 

16bit スキャンは、1 回のスキャンでは miRNA 発現のダイナミックレンジをカバーしきれないため、XDR

機能を使って 2 回の PMT gain の異なる連続スキャンを行ない、その結果を統合して使います。この場

合、XDR ratio を指定する必要があります。miRNA のデフォルトの XDR ratio は 0.05 です。 

20bit で 1 回スキャンしたデータと 16bit で XDR スキャンをしたデータは、結果にほぼ違いはありません。 

 

SureScan をお使いの場合 

1. PC を起動し、ログインします。 

2. スキャナの電源を入れます。 

3. スキャナの Status Indicator Light が消えるまで 1～2 分待ちます。 

4.  をダブルクリックして Agilent Microarray Scan Control を起動します。 

5. ソフトウェアでスキャナが認識されるとスキャナの初期化(Initialize)が始まります。ウィンドウ右下の

ステータスをご確認ください。 

 

スロットステータス

インジケータ 

ファンクションボタン 

セッティングペイン 

ステータスバー 

メニューバー 

スロットテーブル 

ログ 
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6. 初期化が終了すると、ファンクションボタンのOpen Doorボタンがアクティブになります。クリックし、

カセットにスライドをセットします。どの位置にセットしても構いません。 

スライドホルダのカバーはきちんと閉まっていることを確認して下さい。完全に閉まっていない状態

でスキャンを開始すると、スキャナ内でスライドホルダが引っかかってしまい、エンジニアによる修理

が必要となることがあります。 

スライドがセットされているカセットは青色で表示されます。また、各パラメーターの編集ができるよ

うになります。 

注意  SureScanの蓋は手動で開けることが出来ません。必ずソフトウェア上で「Open Door」もしくは

「Close Door」から操作して下さい。 

 

7. Scan Protocolからプロトコルファイルを選択します。AgilentG3_HiSen_miRNA（8x60Kの場合）ま

たはAgilentHD_miRNA（8x15Kの場合）を選択します。 

ウィンドウ右側のセッティングペインでスキャン設定を確認してください。変更する必要があれば個

別にプルダウンメニューで変更できます。AgilentHD_miRNAを選択した場合はResolutionを”5 

um”から”5 um high sensitivity”に変更してください。この設定をScan Protocolとして保存する場合

は次ページをご参照ください。 

 

8. 必要があればデータの保存先を変更します。※D drive内のフォルダを指定してください。 

 

 

9. ScannerのステータスがReadyであることを確認し、All to Queueボタンをクリックし、Queueに追加

します。 

10. Start Scanボタンをクリックするとスキャンを開始します。 

スライドがセットさ

れると青色で表示

されます。 
プロトコルファイルを選択

します。 
データの保存先を指定します。 
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11. スキャンが終了し、Open Doorボタンがアクティブになったら、クリックします。 

12. スライドホルダを取り出します。 

13. コントロールソフトを閉じた後にスキャナおよびPCの電源を消してください。 

 

≪変更したプロトコルをScan Protocolとして保存する場合≫ 

1． メニューバーの Tools から「Scan Protocol Editor…」を選択します。  

2． AgilentHD_miRNA を選択し Scan Protocol Editor 画面下部の「Save As」をクリックし、「Save As 

New Name」ボックスで、今から設定する新しい Protocol Editor に分かりやすい名前（例：

AgilentHD_HiSen_miRNA）をつけて保存します。  

3． 設定した新しい名前の Protocol が選択されているのを確認した後、Resolution という項目のプル

ダウンメニューを展開し、”5 um”から”5 um high sensitivity”に変更してください。 

 

4． Resolutionが間違いなくHigh Sensitivityに設定されており、その他の項目に変更が加えられてい

ないことを確認した後、ボックス下部の Save をクリックします。  

今後のスキャン時には、この新規作成した Protocol を Scan Protocol として選択するだけで、高感度設

定でスキャンをすることが出来ます。  
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白黒反転表示白黒反転表示

 

7. ハイブリダイゼーション後のマイクロアレイの画像化 

ここでは、Feature Extraction ソフトウェアによるイメージの簡単な確認法をご紹介します。より詳細につ

いては、Feature Extraction 英語版マニュアルをご覧ください。 

Feature Extraction Ver.8 以降の画面は、Project Work Window（スポットの数値化の画面）と Image 

Work Window（イメージ確認の画面）があります。 

 

① Feature Extraction ソフトウェアの起動 

以下のいずれかの方法で、Image Work Window を開き、TIFF イメージを確認します。 

・tif イメージファイルをデスクトップの Feature Extraction ショートカット  にドラッグ＆ドロップ 

・Feature Extraction ショートカット     をダブルクリックしてソフトを起動後、メニューバーの 

  【File>Open > Image】で開きたいファイルを指定 

 

② バックグランドのむらの確認 

ログスケール表示によりバックグランドのむらを確認します。 

 

 

 

 

 

 

③ 表示カラーの変更 

Color > xxxxx を選択すると表示カラーが変更します。 

例：メニューバーの【Color > Reverse Gray Scale】を選択すると、白黒反転表示になります。 
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④ イメージデータのスケールの確認 

Green チャンネルのデータレンジを確認します。 

＜注意＞ここでの確認はイメージデータ全体に対するものとなります（スポット以外のエリアも含みます）。 

スポットレベルで確認する（例：コントロールスポットを除く全遺伝子スポットに対してデータスケールを確認する）ためには、

スポット定量が必要になりますので御注意ください。 

 

カラーレンジの設定 

 をクリック。 

イメージデータ全体に対し、１％から９９％の設定 

（デフォルト）における最大値・最小値を確認します。 

 

 

⑤ クロップモードの ON/OFF 

クロップモードが ON の場合、ポインタの横にひし形のマークが表示されます。イメージをクロップすると

新しいウィンドウで切り取った画像が表示されます。OFF の場合、クロップ時にその大きさに合わせてウ

ィンドウが拡大表示されます。 

をクリックすることで ON/OFF の切り替えができます。 

 

 

⑥ ラインプロット 

スポットの形状を確認します。 

 

 

 

 

 

 

 

 

 

 

 

 

クロップモードを ON にしたまま、ラインプロットを見たい領域の左上隅で右クリックし、そのままポインタを領域

の右下隅までドラッグさせます。次にクロップモードを OFF にし、ラインプロットを見たい位置（上の図の場合、

赤線上のどこでも構いません）にポインタを合わせてダブル左クリックします。 

このように、Feature Extraction する前に、ヒストグラムやラインプロットを使ってデータ抽出の妨げの可

能性となる異常スポットやバックグランドの確認をすることができます。 
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8. Feature Extraction ソフトウェアで数値化を行う前に 

①Project Work Window を開く 

 

  以下のいずれかの方法で、Project Work Window（スポットの数値化の画面）を開き、必要なファイ  

  ルがあるかどうかを確認します。 

 

   ・メニューバーの【File > New > Standard Project】を選択 

・Feature Extraction ショートカット     をダブルクリック 

 

 

Project 

Explorer 

Pane 

Project Work Window 

Grid Template Browser 

FE Protocol Browser 

QC Metric Set Browser 
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②必要なファイルの確認 

   Grid Template Browser：インストール済みのデザインファイルまたは Grid File のリスト表示。ここ

 に今から数値化するマイクロアレイの種類に対応したデザインファイルがあるか確認する。 

 確認方法： (1) マイクロアレイのデザイン ID を確認する 

   デザイン ID…アレイスライドのラベルに印字されている、または TIFF ファイルのファ

   イル名に記載の 25 から始まる 12 桁の番号の、25 に続く 5 ケタの番号に 0 

   を付けた 6 桁の番号(252800410025 であれば 028004 がデザイン ID) 

  (2) Grid Template Browser に目的のデザイン番号のファイルがあるかを確認する 

   （028004_D_F_20110524 等） 

 必要なデザインファイルがなければ、eArray からダウンロードする(巻末の Appendix1 参照)。 

 

  

   FE Protocol Browser：各数値化ステップのアルゴリズムのパラメータを含む、アプリケーションご

とのファイル。ダブルクリックで開いて変更・保存可能。 

  FE プロトコル例） GE1_107_Sep09 

  GE1…遺伝子発現 1 カラーアレイ用 

  GE2…遺伝子発現 2 カラーアレイ用 

  CGH…アレイ CGH 用 

  ChIP…ChIP-on-chip 用 

  miRNA…miRNA アレイ用 

  107…このプロトコルファイルが対応している Feature Extraction のバージョン 

   （お使いのソフトウェアのバージョンに合った FE プロトコルを使って下さい） 

  Sep09…ファイルの更新時期（より新しいものを使って下さい） 

  NonAT…アジレント製以外のアレイデータを数値化する時に必要。 

 必要な FE プロトコルファイルがなければ、ダウンロードする(巻末の Appendix2 参照)。 

 

   QC Metric Set Browser：各アプリケーションの QC メトリック（実験の成否判断の閾値）のセット。 

 Feature Extraction10 以降で数値化すると、いくつかの実測値が、アプリケーションごとに設定

 された閾値の範囲内かどうかを QC レポートに自動出力する。 

 必要なメトリックセットファイルがなければ、下記 Web Site からダウンロードする 

 https://www.agilent.com/en/qc-chart-tool-metric-sets

デザインファイルは、各プローブのマイクロアレイ上の位置情報と、対応する遺伝子の情報を含んだ

ファイルです。ファイル名の末尾の日付はファイルの更新日付で、更新されると遺伝子の Annotation

情報は変更されることがあります。より新しい情報でデータ解析をしたい場合、既にデザインファイル

が存在しても、eArray からダウンロードした最新のデザインファイルをお使い下さい。 

(GeneSpringで解析をする場合、Annotation情報はデザインファイルの情報に依存しないため、更新

日付は古くても問題ありません) 
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③必要なファイルのインポート 

  ■Grid Template Browser 内に新規デザインファイルを加える場合 

 （この操作は Feature Extraction に必要なデザインファイルがない場合、もしくはより新しいデ

  ザインファイルで数値化したい時のみ必要になります） 

 

 (1)eArray から必要なデザインファイルをダウンロードする(巻末の Appendix1 参照)。 

 (2)ダウンロードしたデザインファイルを解凍し、XML ファイルを“日本語が入らないパス”のフォ

   ルダに保存する。 

  ※圧縮ファイルを解凍する際は、Winzip あるいは Windows XP 以降に付属のソフト（解

  凍するファイル上で右クリック＞Open with（プログラムから開く）＞  

  Compressed(zipped)Folders と選択）を使用してください。 

 (3)Grid Template Browser Pane 上で右クリック→Add…を選択後、目的のデザインファイ

  ルを選択。（または、メニューバー【Tools > Grid Template > Add…】を選択後、目的のデザ

  インファイルを選択） 

 

   ■FE Protocol Browser 内に新規 Protocol を加える場合  

 （この操作は Feature Extraction に必要な FE プロトコルがない場合のみ必要になります） 

 (1)FE Protocol Browser Pane 上で右クリック → Import…を選択後、目的の Protocol を選

   択して下さい。 

 （または、メニューバー【Tools > FE Protocol > Import…】を選択後、目的の Protocol を選択） 

 

  ■インポートしたデザインファイルに、適切な FE プロトコルを設定する方法 

 （この操作は新しいデザインファイルをインポートした時のみ必要になります。 

 必要な FE プロトコルが数値化時に毎回自動で割り当てられるようになるため便利です） 

 

 (1)Grid Template Browser Pane に格納されている目的のデザインファイルを選択する。 

 (2)ダブルクリック（または、メニューバー【Tools > Grid Template > Properties】を選択）して、

 FE Grid Template Properties（右図）の window を開く。 

 

 (3)Default Protocol（2 カラーデータ用）、 

   Default One Color Protocol に適切な Protocol を 

   指定します。 
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9. Feature Extraction ソフトウェアによる数値化 

STEP1. Feature Extraction ソフトウェアの起動 

 以下のいずれかの方法でProject Work Windowを立ち上げて、スポット数値化を行います。 

 ・デスクトップのFeature Extractionショートカット  をダブルクリック 

 ・【Start>Programs>Agilent >Feature Extraction】 からソフトウェアを開始 

 

STEP2. FE projectへ数値化するイメージ(.tif)を追加 

ツールバーにあるAdd New Extraction Set(s)のアイコン をクリックします。あるいは、Project 

Explorer内で、右クリックをし、Add Extraction…を選択します。 

 

1. tif.ファイルを選択して、Openをクリックします。複数のファイルを指定するときには、ShiftまたはCtrlキー

を押しながら選択します。 

  ※XDR設定でスキャンしたtif画像は、2種類（HおよびL)のScan Fileがイメージファイルとして認識

   されます。その際、HおよびLのScan Fileが、同一フォルダ内に存在する必要があります。 

  

2. Project Explorer内のProject下の階層にExtraction Setが、さらにExtraction Set下の階層にImage 

File、Grid File、Protocolが現われることを確認して下さい。空欄の項目がある場合、適切なGrid 

TemplateとProtocolを選択してください（次頁参照）。 

 

Project ：Feature Extraction の Run 設定全体をまとめた情報です。 

 1 つ以上の Extraction Set から構成されています。 

Extraction Set ：解析する tif 画像ごとに作成されます。 

 Image File、Grid Template (Grid File)、Protocol から構成されています。 

 Image File ：解析対象のマイクロアレイ画像のことです。 

 Grid Template (Grid File) ：Grid 情報です。Agilent アレイの場合はデザインファイル

 を意味します。 

 Protocol ：イメージの数値化の際、適用する解析アルゴリズムの設定です。 

Extraction Set

Image File

Grid Template (Grid File)

Protocol

Project

Extraction Set

Image File

Grid Template (Grid File)

Protocol

Project
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STEP3. 数値化設定の確認とProjectの設定 

１.数値化設定の確認をします。 

・ Project Work Window中央のExtraction Set Configurationタブシートを選択。 

 

・ Extraction Setで用いる構成（TIFFイメージ、デザインファイル、Protocol）を確認します。 

空欄になっている場合、プルダウンから選択することができます。またプルダウン内にも必要

なファイルが表れない場合、p.48を参照の上必要なファイルをインポートして下さい。 

 

2. Projectの設定、出力ファイルの設定を行います。 

・ Project Propertiesタブシートを選択する 

あるいは、Project Explorer内の解析に用いる 

Projectをダブルクリック。 

・ Projectの設定を確認、変更をします 

（解析結果ファイルのOutputフォルダの設定、 

結果としてOutputするファイル種類の設定など）。 

 

 

 

 

 （ソフトウェアのデフォルト設定を変更したい場合は、メニューバー【Tools > Preference】で設定画面を開   

  き、【FE Project> Output & Data Transfer】を選択して下さい）
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(1)出力方法の設定 

  出力方法は以下の4つから選択することができます。 

None （出力しない） 

Local file only （ハードディスクに出力する） 

FTP send only （外部にファイルを転送する） 

Both local file and FTP send （両方に出力する） 

デフォルトでは、TEXT、Visual Results、QC Reportの結果を出力されるよう、これらの項目の設定がLocal 

file only、それ以外の項目（MAGE、JPEG、Grid等）は、Noneとなっています。 

 

(2)出力ファイルの設定 

MAGE アレイの結果をXML形式で出力。解析にロゼッタ社のリゾルバー/ルミネーターを使用す 

る場合、Array Expressにデータを転送する場合などに必要。 

  JPEG  各アレイ画像をJPEG形式で出力。この画像ファイルからは数値化はできないので注意。 

  TEXT  アレイの結果をタブ区切りテキスト形式で出力。解析にGeneSpring、エクセルなどを使用

する場合に必要。 

※TEXTファイルのOutput設定は、以下のOutput Package設定が可能です。 

Full ：数値化項目全ての結果を出力します。 

Compact ：数値化項目の一部（通常、データ解析に用いると考えられる項目）の結果を 

出力します。Fullに比べ、約1/3のファイルサイズとなります。 

GeneSpring, DNA Analyticsを使用する場合はCompact推奨。 

  Visual Results 数値化結果のTIFF画像へ重ね描きするのに必要な.shpファイルを出力。 

  Grid  グリッド合わせの詳細（スポット位置情報など）をCSV形式で出力。 

  QC report 実験の成否をチェックするための項目を含んだレポートを出力。 

※QC reportはPDFファイルあるいはHTMLファイルで出力できます。 

PDFファイルは”Local PDF file only”を、HTMLファイルは””Local HTML file only”を選択してくだ

さい。HTMLファイルの場合は数値化後、必ずQCReport_Graphsというフォルダと同じフォルダ

にHTMLファイルを保存してください。 

 

(3)QCメトリックの設定（ver.10.7より前のバージョンをお使いの場合） 

Project Propertiesタブシート一番下部“Other”の“QC metric set”プルダウンから

“miRNA_QCMT_Jan09”を選択します。 

プルダウンに“miRNA_QCMT_Jan09”が表示されない場合

https://www.agilent.com/en/qc-chart-tool-metric-setsからファイルをダウンロードし、QC Metric 

Set Browser上で右クリックしてファイルを追加して下さい。 

 

3. 設定を確認したら、Projectの保存を行います。 

・ メニューバー【File > Save As】を選択し、FE Project Data Files (.fep)ファイルを保存するための適切

なフォルダを選択もしくは作成して下さい。 

・ フォルダ指定後、Projectに名前を付けて保存して下さい。 
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STEP4. Feature Extraction Project をスタート (数値化の実行) 

・メニューバー【Project > Start Extracting】またはProject Run Mode On/Offボタン を選択すると、

Projectがスタートします。スタート後、Summary ReportタブとRunning Monitorが現われます。 

Summary ReportタブシートSummary Reportタブシート

 

 

進行状況は、Running Monitorに表示されます。Project終了後、Summary Reportタブを選択していると、

Project Work Windowに、Project終了を示すSummaryが現われます。 

 

Running MonitorRunning Monitor

 

 

Project 終了後Project 終了後
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STEP5. QC Reportの確認 

 

1. 出力ファイルの設定で、QCReportを選択した場合、自動でQC Reportが作成されます。 

2. ”PDFファイル形式のQCReportファイル”を開いて下さい。QC Reportを確認することができます。 

 

 

 

※8x15Kおよび8x60Kフォーマットの出力結果は、ファイル名末尾”…_1_1” ～ “…2_4” の8つのデータが得

られます。それぞれ、下図の位置のアレイに対応しています (バーコードラベルを左側、Inactiveサイトが手前

の状態)。 

 

 

 

 

 

 

1_1 1_2 1_3 1_4

2_1 2_2 2_3 2_4

1_1 1_2 1_3 1_41_1 1_2 1_3 1_4

2_1 2_2 2_3 2_42_1 2_2 2_3 2_4
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QC Metricsは、以下の項目と閾値を示します。(FE10.7以降) 

（各項目の詳細は、メニューバー【Help > Reference Guide】で確認することができます。） 

 

 

Step 6. Visual Resultの確認 

  

 Step3で選択したVisual Resultファイルを使ってフラグ等の確認をします。 

1. Feature Extraction内に、画像を表示させます。XDRスキャンをした場合、ファイル名の末尾に_Hが付い

た画像を開きます。 

2. メニューバー【Feature Extraction > Load Visual Result】を選択します。 

3. 該当するVisual Resultファイル（.shp）を選択します。このとき表示させている画像に対応するファイルを

選択してください。 

4. 画像にVisual Resultが重ね描きされます。 

5. クロップモードやズームイン機能、ログスケール表示機能を使って表示を調節します。 

 

 

 

 

 

 

 

 

 

 

6. メニューバー【View > Extraction Results】 からVisual Resultsの表示法を選択できます。 

メニューバー【Help > Feature Extraction Output Quick Reference】で各リングの色が示すアウトラ   

イヤーを確認できます。 
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Step 7. 出力ファイルの確認 

 GeneView(miRNA マイクロアレイデータ特有のテキストファイル)について 

 

miRNA FE protocolでは、タブ区切りテキストファイル・MAGE-MLファイル・QCレポート

などに加え、GeneViewという名前のmiRNA分析に特有のタブ区切りテキストファイルを

出力します。 

 

     GeneViewファイル名例     2516436XXXXX_S01_１_１_GeneView.txt 

         （↑アレイバーコード   ↑スライド上のアレイの位置） 

 

このファイルは、以下の5つの項目を含みます。 

内容 項目  

Systematic Name プローブがハイブリするように設計されたターゲット配列のID 

 (非コントロールプローブではmiRNAのID) 

Control Type フィーチャーのコントロールタイプ 

 0  コントロール以外のプローブ 

 1か-1 コントロールプローブ 

  （グリッド合わせやSpike-Inの評価に使うもので、解析には使用しません） 

gTotal Gene Signal 各miRNAについて計算されたシグナル値 

gTotal Gene Error シグナル強度のエラー値 

gIs Gene Detected シグナル値がエラー値よりも十分高く検出されているかの判定 

 1  シグナル値がエラー値の3倍以上である 

 0  シグナル値がエラー値の3倍より低い 

 

 

GeneView ファイルをエクセルで開いた例 

 

※解析ソフトウェア GeneSpring GX v10 以降では、テキストファイル（Compact あるいは Full）を

取り込みます（GeneSpring 内で自動的に gTotalGeneSignal が計算されます）。それ以外の解析

ソフトウェアを用いる際は、GeneView ファイルを使います。 
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TotalGeneSignal の算出方法について 

miRNA マイクロアレイでは、1 つの miRNA に対応する複数のプローブがデザインさ

れており、それぞれのプローブに複数の繰り返し Feature が存在します。GeneView

ファイルでは、１行が１つの”Gene”(=mature miRNA)に対応し、その miRNA の発現

レベルを TotalGeneSignal としてレポートします。 

        ※“Gene”＝アレイ上にある、固有の 556 個（Human ver.1）の Systematic Name に対応 

                            miRNA アレイには、470 種類のヒト miRNA と 64 種類のウィルス miRNA、またコント             

                            ロールを含んだ 556 種類の”Gene”に対する約 15,000 のスポットが搭載されています。 

 

1. 以下のステップで、TotalProbeSignal を算出する 

 Step1.EffectiveFeatureSizeFraction を算出する 

  （スポットの中の、シグナル抽出計算に用いられたエリアの割合） 

 

 Step2.シグナル強度の平均値を算出する 

（同じ配列をもつ全ての繰り返しプローブのうち、フラグの立っていないプロ

ーブの ProcessedSignal 間の Mean 値） 

 

  Step.3 スポットの面積値を算出する 

    (＝π×（スポットの幅÷2）×（スポット高さ÷2）) 

  

  Step4. TotalProbeSignal を算出する 

TotalProbeSignal＝シグナル強度の平均値 （Step2 より） 

×スポットの面積値 （Step3 より） 

×総繰り返し Feature 数  

×EffectiveSizeFraction （Step1 より） 

×Weight   （1/30000） 

 

1. 下の点以外は１と同様に、TotalProbeSignalError を算出する 

 

Step2. エラー値の RMS（Root Mean Square）を算出する 

（同じ配列をもつ全ての繰り返しプローブのうち、フラグの立っていないプー

ブの ProcessedSignalError 間の RMS） 

 

2. TotalGeneSignal を算出する 

（１つの遺伝子に対してデザインされた全 Probe の、TotalProbeSignal の和） 

 

3. TotalGeneSignalError を算出する 

（１つの遺伝子に対してデザインされた全 Probe の、TotalProbeSignalError の和の

RMS） 
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Appendix 1 Feature Extraction 用デザインファイルのダウンロードサイト 

デザインファイルは eArray からダウンロードすることができます（ご使用の際、ご登録が必要となります）。 

 【eArray】 http://www.chem-agilent.com/contents.php?id=29443 

 

1．お使いのマイクロアレイのデザイン番号 (Design ID)を確認します。 

デザイン番号： マイクロアレイのラベルに記載さ

れている 12 桁の番号の「25」に続く 5 桁の番号

の頭に「0」を付けた 6 桁の番号。この 12 桁の番

号はFeature Extraction の出力ファイルからも確

認できます。 

 例） 12 桁の番号が 251469312345 の場合… [14693]の頭に「0」を付けた 014693 

 

2 ． eArray に ロ グ イ ン 後 、 画 面 右 上 の

「Application Type」を miRNA に変更 

 

 

 

 

 

 

3．HomeタブでMicroarrayにチェックを入れ、Design ID欄

にデザイン番号を入れてSearch。 

 

 

  

4. Search 結果から「Download」を選択 

 

5.Internet Explorer の Pop Up Blocker   

を Off にし、 「EXTERNALFULGEML」  

（＝Feature Extraction 用デザインファ  

イル）をダウンロード 

http://www.chem-agilent.com/contents.php?id=29443
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Appendix 2 Feature Extraction 用 Protocol のダウンロードサイト 

 

弊社スポット数値化ソフトウェア、Feature Extraction によるスポットの数値化を行う際、イメージの数値

化に適用する解析アルゴリズムを設定した Protocol ファイルが必要です。 

Agilent が推奨している Default 設定の Protocol ファイルは、下記サイトからダウンロードが可能です。 

 

https://www.agilent.com/en/download-protocols-feature-extraction-software 

 

※ プロトコルファイルは、最新のものではなく、お使いの Feature Extraction Software と一致したバ 

ージョンをお使い下さい。 

※ 各 Protocol の詳細は、Protocol Use のリンク先をご参照下さい。 

 

 

 

https://www.agilent.com/en/download-protocols-feature-extraction-software


 

58 
 

Appendix 3 Total RNA の評価 

 

推奨の Total RNA の抽出方法 

Total RNA の抽出方法は、収量、Total RNA 中に含まれる Small RNA の量、Total RNA の定

量結果のような点で、サンプルに影響を及ぼします。 

次の4つは、Agilentがアレイによるプロファイリングに使用できることを確認した方法です。 

•Agilent Absolutely RNA miRNA Kit - catalog number 400814 

•Qiagen miRNeasy Mini Kit - catalog number 217004 

•Applied Biosystem mirVana miRNA Isolation Kit - catalog number AM1560 

•Invitrogen TRIZOL Reagent (100 mL) - catalog number 15596-026 

 

これらのキットを使用する際は、Total RNA 抽出法のみを使い、Small RNA Enrichment 法を

使わないようにご注意下さい。また、比較したいサンプルには、同じ抽出法を使うことが非常に

重要です。抽出法が変わると、miRNA のプロファイリングに影響を及ぼす可能性があります。 

 

 抽出後は、以下に示すような方法で、RNA の品質チェックを行って下さい。 

 

Step1．UV-Vis による Total RNA の評価 

 ・少なくとも、以下の 4 つの波長における吸光度を測定して下さい。 

A230 グアニジンイソチオシアネートや塩類・糖類、その他有機溶媒などの混入を

検出します 

A260 TotalRNA の濃度を測定します 

A280 タンパク質・フェノールの混入を検出します 

A320 異常な吸収がないかをチェックします 

 

 ・以下の基準を満たしているかをチェックして下さい。 

 A260/A280＝1.8～2 

この基準を満たしていない場合、RNA を正確に定量することができないため、マイクロア

レイデータに影響を及ぼします。サンプリングをやり直すか、混入物を除去するための追

加の精製を行って下さい。 また、可能であれば UV スペクトルを採取し、スペクトルパター

ンを記録して下さい。 

 

※A260/A230>2 という基準も、コンタミネーションの程度を知るために有効です。Trizol のよう

な有機溶媒を使用する抽出法では、その有機溶媒のサンプルへの混入により、230nm の

吸光度が上がってしまうことがあります。また、260nm の吸光度にも影響して Total RNA の

定量値を不正確にする危険性があります。Trizol などの混入を除去するには、Trizol の抽出

プロトコルの後に、クロロフォルム抽出を更に 1・2 回追加してから、アルコール沈殿を行って

下さい。 
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Step2．Agilent 2100 Bioanalyzer による Total RNA の評価の準備 

 

以下は miRNA マイクロアレイ実験の中では任意のステップとなりますが、Agilent は Total 

RNA と、Total RNA 中の small RNA の画分の評価をされることをお勧めいたします。この章

では、ラベリングとハイブリダイゼーションに先立って、Total RNA と Total RNA 中の small 

RNA の画分を評価するための一般的なガイドラインについてご説明します。 

 

・Total RNA の評価 

Agilent 2100 Bioanalyzer を用いて Total RNA の評価を行うと、ラベリングとハイブリ

ダイゼーションの前にサンプルの質についての情報が得られます。サンプルの濃度

に応じて、RNA6000 Nano/Pico kit をそれぞれの assay と共に用います。 

Agilent 2100 Expert Software は、Total RNA の質の指標として RNA Integrity 

Number（RIN）を自動で算出します。RIN を使うと、RNA の分解具合などの質の標

準化が容易になります。品質の悪い Total RNA による実験結果の偏りを排除するた

めに、RIN の各々の閾値を決定することができます。 

 ・Small RNA の評価 

Small RNA assay では Total RNA 中の、miRNA が存在する Small RNA の領域に

注目した評価を行います。Agilent 2100 Bioanalyzer の Small RNA Kit を Small 

RNA assay と共に用います。 

 

RIN や Bioanalyzer に関するより詳細な情報は、以下のウェブサイトより、 “RNA integrity num-

ber(RIN)-Standardization of RNA quality control” (part number 5989-1165EN)をご覧下さい。

www.agilent.com/chem/labonachip 

・ このステップでは、以下の機器・試薬キットが必要になります。 

  

・ それぞれの試薬キットは、以下のサンプルに対応いたします。 

    

http://www.agilent.com/chem/labonachip
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Step3．Agilent2100 Bioanalyzer を用いた RNA サンプルの評価 

Total RNA の評価 

・ Total RNA の評価には、Agilent RNA 6000 kit を用い、キットの説明書に沿って下さい。 

・ この分析によって得られるエレクトロフェログラムでは通常、18S と 28S リボソーマル RNA の、少なくと

も二つの区別できるピークが見られます。5S リボソーマル RNA は RNA の精製法によって高さが変わ

ります。カラムを用いて Total RNA を精製した場合、これは通常低くなります。LM（Lower Marker）は、

サンプル間の泳動時間のずれを調節するための標準物質のピークです。 

・ 下の図では、分解具合の異なる、3 種類の Total RNA を分析した結果のエレクトロフェログラムを示し

ています。お客様が、品質の悪い Total RNA による実験結果の偏りを排除するために、RIN の各々の

閾値を決定することが重要となります。 

 

 

 状態の異なる（ヒト）Total RNA を Eukaryote total RNA Nano assay によって分析した結果 

赤…RIN 8.1 青…RIN 5.9 緑…RIN 3.6 
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Small RNA の評価 

・Small RNA の評価には、Agilent Small RNA kit を用い、以下の方法に沿って分析をして下さい。 

１） 試薬キットの説明書にあるとおり、2100Bioanalyzer の電極が洗浄されてあることを確認する 

２） Agilent 2100 Expert Software(ver. B.02.04 以上)を立ち上げ、2100 Bioanalyzer の電源を入

れ、通信を確認する 

３） 試薬キットの説明書に従い、サンプル・ラダー・チップを準備する 

４） 5 分以内に 2100Bioanalyzer にチップをセットし、分析を開始する 

５） 結果を評価する 

・ この分析によって得られるエレクトロフェログラムでは通常、10nt から 150nt の範囲の Small RNA の、

複数のピークまたはバンドが見られます。miRNA は 10nt から 40nt の範囲に位置し、この位置のピー

クまたはバンドの存在量は、miRNA の総量によって変わります。下の図は、Total RNA サンプルを

Small RNA assay によって分析したエレクトロフェログラムの例です。 

・ miRNA のマイクロアレイ実験の結果と関連づけるため、泳動結果を記録しておくことができます。しか

しながら、マイクロアレイの方が本キットより感度が高いため、この Small RNA assay の結果が必ずし

もサンプル中の miRNA の指標になるとは限りません。 

（セルラインなどでは、この領域にピークが検出されなくても、アレイでは十分なシグナル強度が得

られる場合があります） 

    

 

 Total RNA 中の Small RNA の分析によるエレクトロフェログラム例 

Small RNA に分類される 10nt から 150nt の領域のうち、miRNA は通常 10nt から 40nt の範囲に位置する 
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Appendix 4 スキャナの詳細な起動手順 

 

B スキャナまたは C スキャナをお使いの場合 

1. PC の電源を入れログインします。 

2. PC が完全に立ち上がってからスキャナの電源を入れます。 

3. スキャナ前面の LED が緑とオレンジに点灯している（点滅ではありません）ことを確認します。電源を

入れてから数分かかります。 

4. スキャンコントロールソフトを立ち上げます。スキャナと PC の通信が始まってから、レーザーが安定

するまで 20 分ほどかかります。 

 

SureScan をお使いの場合 

1. PC の電源を入れログインし、スキャナの電源を入れます。 

2. スキャナ前面右上にある LED がオレンジ→白色の順に光り、しばらくすると消灯します。LED が消灯

するまで待ちます。（電源を入れてから数分かかります。） 

3. スキャンコントロールソフトを立ち上げます。 

4. スキャナの初期化が始まりますので、初期化が終わるまで待ちます。 

5. スキャンコントロールソフトの画面右下にある Scanner Status が Ready になることを確認します。 

※デフォルト設定では、Ready の状態で 5 分間、スキャン開始せずに待機すると、省電力のためレー

ザーが OFF になります。スキャンのために Queue に入れるとレーザーが自動点灯し、Status が

Ready になります。 

 

 

いずれのスキャナでも、スキャン後はスライドフォルダを取り出し、コントロールソフトを閉じてください。そ

の後スキャナおよび PC の電源を落としてください。 

 

通信エラーが起きた場合などは、PC とスキャナの電源を切った後 10～15 分ほど待ち、上記手順で PC

とスキャナの再起動をお試しください。それでも改善しない場合は、エラー内容を弊社サポート窓口まで

お知らせください。 
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SureScan で’Initialize logger failed’のエラーが出た場合の対処法 

 

SureScan の場合、スキャンコントロールソフト を立ち上げた際に以下のエラーメッセージが出て、スキャ

ナ本体と通信できない事がありますが、次の手順でエラーを解消することができます。 

 

 

1. 上記のエラーメッセージの OK を押します。 

2. スキャンコントロールソフトで Tool > Log files と選択し、ログファイルのフォルダを開きます。 

3. スキャンコントロールソフトを終了し、装置の電源もオフにします（PC の再起動は必要ありません）。 

4. 上記 2 で開いたフォルダ、C:\ProgramData\Agilent\MicroArrayScanner\Logs  の中にある、

ExceptionLog.txt というファイルをデスクトップなど別のフォルダに移します。 

5. 再度、スキャナ本体の電源をオンにし、スキャナ右上の LED ランプが黄色に点灯し消灯後、スキャ

ンコントロールソフトを立ち上げてください。 

6. 移動した ExceptionLog.txt は元の場所には戻さず、破棄して下さい（スキャンコントロールを立ち上

げた際に Log のフォルダには既に新しい ExceptionLog.txt が作成されています）。 

 

C ドライブ中に ProgramData がない場合、ProgramData が隠しファイルになっていますので、下記の方法

で表示ください。 

【Windows 7】 

a)     スタートメニューから [Control Panel ] を選択 

b)     [ Appearance and Personalization ] を選択 

c)     [ Folder Option]を選択 

d)     [ Folder Option] ダイアログが表示されるので、[ View ] タブを選択 

e)     [ Advanced Settings] の[ Hidden files and folders ]の中で[ Show hidden files, folders, and drives ] 

を選択し、apply 

【Windows 10】 

a)     スタートメニューから Explore を選択、またはスタートメニューを右クリックし File Explore を選択 

b)     現れた Explore ウィンドウで View タブ を選択 

c)     File name extensions および Hidden items にチェックを入れる 
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Appendix 5 データのノーマライゼーションに関しての推奨 

 

miRNA のプロファイリングの研究者の中では、現時点で『一般的に推奨できる、miRNA のデータのノー

マライゼーション法はない』という考えが共通認識となっています。 

それは、miRNA の発現では、ほとんどの遺伝子発現ノーマライゼーション法が前提としている、以下の

仮説が成り立たないと考えられているためです。 

➢ サンプル間で、遺伝子の大多数は発現が変化していない 

➢ サンプル間で、発現上昇と発現減少は全体として同等である 

➢ サンプル間で、総発現量は一定である 

・ miRNA では、どのサンプルでも一定の発現レベルを示す『真のハウスキーピング遺伝子』

というものは知られていない 

・ サンプル間で、他の small RNA（rRNA,snRNAs,5S ｔRNA など）も miRNA 同様に変化し

うる 

 

アジレントのプラットフォームを使って得られた miRNA のプロファイルは、実験が理想的に行われたとい

う仮定のもとで、以下の理由から、“実質上”total RNA の量によってノーマライズされていると考えられま

す。 

・ 等量の total RNA が、それぞれの実験に使用されている 

・ 標識されたサンプル全量が、アレイ上にハイブリダイゼーションされる 

 

全遺伝子のシグナル強度の 90 パーセンタイルの強度でノーマライズするなどの、グローバルノーマライ

ゼーション法を使うと、アレイの繰り返し実験間でのシグナル強度をより良く一致させることができる場合

もあります。このようなノーマライゼーション方法は、比較するサンプルが極めて似た性質をもち、サンプ

ル間での miRNA の発現レベルの差が小さいことが予想される場合に使用することができます。 

そのようなサンプルではない場合は、どのようなタイプのノーマライゼーションでも、その適用には注意さ

れることをお勧めいたします。たとえ単純なグローバルノーマライゼーションであっても、それを適用する

ことによって、本当のサンプル間での発現差を見えなくしてしまう可能性があります。Quantile ノーマライ

ゼーションのような、より条件の厳しいノーマライゼーション法は、使用されないようにお勧めいたします。

このようなノーマライゼーションの前提となる条件はより厳しく、miRNA 実験ではこれらの前提は成立し

ない可能性が高いためです。 
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Appendix 6 よくある質問 

Q1．なぜ実験開始直前に Total RNA サンプルを 50ng/uL に希釈するのですか？ 

A1．約 50ng/uL にまで希釈することで、サンプルの液量を増やすことになり、ピペット操作の 

  ばらつきによる実験誤差を軽減することができます。マイクロチューブの壁へ RNA が吸着する 

  と、濃度が正確に保たれないため、50ng/uL に希釈された状態では、保存をしないで下さい。 

 

Q2．DMSO を加えて熱した後、またハイブリダイゼーションバッファを加えて熱した後の冷却は、 

   氷水の代わりに氷を使用してもいいのですか？ 

A2．このステップの目的は、RNA を変性された状態に保つことです。氷のみを使用するよりも、氷水

を使用することで、チューブと氷水がより効率よく接触し、チューブがよりよく冷却できます。より再

現性のある結果のために、氷水をご使用下さい。 

  

Q3． このラベリング反応に、サーマルサイクラーを使用できますか？ 

A3．インキュベーションと加熱にサーマルサイクラーを使用することはできます。ただし、100℃で変

性後の急冷にはお使いいただけません。RNA が再アニールするのを防ぐために、冷却は瞬時に

行わなければなりませんが、サーマルサイクラーではそれができません。 

 

Q4． CIP マスターミックスやライゲーションマスターミックスを、混合後に保存することは 

    できますか？ 

A4．これらのミックスは希釈された酵素を含んでおり、保存をすると最適な活性が保たれません。酵

素は一旦希釈をした後は直ちにお使い下さい。酵素を含む全てのミックスは、ご使用直前に調製

して下さい。 

 

Q5．ラベリング過程のサンプルは、いくつかのステップで‐80℃で保存可能ということですが、 

  少しの間であれば－20℃でも保存はできますか？ 

A5．少しの間であれば、可能です。 

 

Q6．1 サンプルのみ、ラベル反応を行っています。CIP やライゲーションはマスターミックスを 

   調製するべきでしょうか？ 

A6．いいえ。1 反応分の試薬を、マスターミックス用の表にある順番で直接加えて下さい。酵素は常

に最後に加えて下さい。 

 

Q7． ハイブリダイゼーションは 20 時間以下でも大丈夫ですか？ 

A7． いいえ。安定したシグナルを得るためには、必ず 20 時間は必要です。長い分（40 時間までは

確認されております）には問題ありませんが、比較するサンプル間のハイブリダイゼーション時間

は一致させるということが極めて重要となります。 
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Appendix 7  Agilent 社ゲノミクス製品ホームページ 

弊社のゲノミクス関連製品の日本語ホームページでは、新製品や最新プロトコル、アプリケーションノートなど

様々な情報を掲載しております。 

 

アジレント ゲノミクスウェブサイト：http://www.agilent.com/chem/genomics:jp 

 

 

 こちらのページにて、最新版のマニュアルをダウンロードしていただくことができます。 
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